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ing legal procedures understandable and useful for average people, as well as for introducing 
numerous innovations in legal service. In 1971, he founded Nolo Press—the national leader in 
self-help legal products—and he is the author of How to Do Your Own Divorce, How to Solve 
Divorce Problems (contested divorces), Make Any Divorce Better, and ten other books. In 1972, 
he introduced what later became known as Legal Document Assistants. Ed Sherman is partner 
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service for people who prefer to do their own divorces. 

CalSupport PRO for Windows
CalSupport™ PRO for Windows was rebuilt from the ground up in 2000 and is now the most 
powerful, sophisticated and usable support program available today. It is lean (less than 1 Mb) 
and lightning fast! CalSupport has been certified by the Judicial Council every year since 1995 
and therefore, by law, it must be accepted in all California courts. It has always been first to re-
lease new tax-year versions, usually in early January of each year, and fastest to add new features 
requested by professional users.

System requirements

Expiration of license on December 31
Each January, new State and Federal tax tables are required for CalSupport to produce accurate 
resluts. Your license expires on December 31 and, on the following March 31, unless you have 
ordered an annual update, the old program will revert to read-only mode, which means you can 
examine existing files but cannot input new information or revise calculations. CalSupport PRO 
starts reminding you of this expiration a month ahead to give you plenty of time to order your 
annual update. 

Windows 95, 98, NT, 2000, XP, Vista, 7, 8, and 10
Runs on Macs that can emulate or boot into a Windows environment
Color monitor with minimum resolution of 1024 x 768
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What it’s all about
The ultimate goal in any support case is much more than just figuring guideline support or cre-
ating arguments to beat the other side. What people want and need most is a fair result that is 
accepted by both parties—a support agreement. This is exactly what CalSupport is designed to 
help accomplish. Along the way, clients will learn a lot, including the correct support figures for 
their case under California guidelines and how to use that information once they have it. They 
will get reports they can understand and show to the other side as a negotiation aid and you can 
give them tips from this manual about how to negotiate a settlement. 

For most clients, working through the support issue is an unfolding process that takes some time 
and thought. With the help of CalSupport, clients will organize their information, learn what sup-
port is all about, and get a clear picture of what’s fair and what they want. If there are children, 
they will develop at least the basic structure of a parenting plan. 

Communication between parents is extremely important. Ideally, your client will buy a copy of 
CalSupport, the consumer version, so he or she can work with it along with you. The CalSupport 
license allows both parties to use the same CalSupport so they can both follow along and work 
with the numbers. This makes your work more effective.

The single best thing anyone can do is to keep all discussion focused on the information and data 
that goes into calculating support. They should not discuss “how much” until both parties have 
had a chance to work with CalSupport worksheets and reports. The parties should stick to the 
facts and let CalSupport say how much support is appropriate, then negotiate around that.

Professional use of CalSupport PRO
Run calculations for clients
Many clients will prefer to have you run support calculations for them and advise them in the 
use and meaning of the results. CalSupport produces worksheets that will help gather data and 
reports that help communicate with the other party. It is up to you to counsel clients in the ideas 
and concepts that will help them gather accurate data, make the results meaningful and make 
communications with the other party more effective.

You can enter data from information provided by the client on CalSupport worksheets, or you 
can sit at a computer with the client and work through the standard entry screens and let them 
participate in the entry of data. This takes more time but it is far more educational and meaningful 
for the client. It helps them understand much more about support and the calculation.

Help clients run their own calculations
You may find it effective to have your client get CalSupport and spend your time counseling them 
in its use. They can download it at www.nolotech.com and register it for $34.95. Working with 
clients this way has several advantages:

• The client has the program with online help.
• The client takes direct responsibility for the data and the results.
• The client can work through a series of scenarios which might not be affordable if you have 
to run all variations at your professional rate.
• It is convenient for you to continue to assist—PRO and consumer versions of CalSupport 
can exchange data via very small data files that can be emailed back and forth.
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Getting started
Before you begin to use CalSupport with clients, go through all the data entry screens and 
study all the help information. Also become completely familiar with information in the Glossary. 
Once you do that, you will have a sound understanding of support in California.

Expert Entry. The Expert Entry screen (Chapter 5) contains all entry items with abbreviated 
titles and no help information, together with results and sophisticated data analysis. Once you 
are completely familiar with all items in the standard entry screens, you will be able to enter data 
much more efficiently in the Expert Entry screen.

In this manual, we assume that you have a basic familiarity with your PC and that you are rea-
sonably comfortable in Windows. We also recommend that you get a basic manual about the 
operation of your computer, especially running the Windows operating system.

QUICK StaRt
Installing CalSupport PRO

It’s easy. Most users will do best to accept the installer’s defaults without change. If you  down-
loaded the installation file from our web site, just double-click on the file. If you received the 
program on a disk, navigate to the disk in Windows Explorer and double-click on setup.exe. 

System date. The date appears on all reports, so it is very important that your computer’s date 
be set correctly. 

Automatic check for updates. When you start CalSupport PRO, it will show you the automatic 
update dialog, which you can use manually or set for automatic periodic checks. Be sure to use 
it, as CalSupport PRO tends to be upgraded through the year, especially in early months.

Network operation
If CalSupport PRO is being used on more than one computer on a network, you need to install it 
on each computer. By using File > Preferences, you can set the location where CalSupport PRO 
saves cases so all cases can be saved on one machine, making backups easier. 

things you must know before you start
a. How guidelines help avoid legal conflict
Child support is very specifically controlled by the statewide guidelines: with few exceptions, if 
the figures going in are correct, the amount of support indicated by the guideline calculation is 
the amount any judge in California will order. Spousal support guidelines are local and discre-
tionary: a judge may consider the guidelines but is not bound by them. However, although any 
amount of spousal support is possible, as a practical matter, when spousal support is requested, 
the majority of spousal support orders fall near the guideline amount. 

CalSupport changes the focus of discussion from “how much?” to “is this data correct?” which is 
much easier to negotiate. All the parties have to do now is show each other documents to justify 
income and expenses on both sides and CalSupport will settle “how much.” It costs so much to 
get a lawyer and go to court that it really doesn’t pay to battle over support; just negotiate around 
the guidelines. Because of guidelines, it is much easier to get an agreement than ever before.
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b. Gathering necessary information
To calculate support, you have to enter all income, certain expenses and tax data for both parties. 
It is unlikely that anyone will have all this at their fingertips, so CalSupport has a worksheet listing 
everything they need to know. Worksheets are under the Reports menu. Provide the client with 
appropriate worksheets and copies for the other party. People need to be very open with each other 
about information because 1) it’s a good idea to be cooperative, and 2) the law requires it. Parties 
have a legal right to see each others’ tax returns, current pay stubs, and financial records. 

c. Precise data vs. estimates
Professional data analysts are guided by the GIGO principle: “Garbage In, Garbage Out.” Your 
result is only as accurate as your data. If you enter estimates into CalSupport, you will dilute the 
quality of the results. However, for some entries, agreement is more important than accuracy. 
Also, it takes time to gather data so people might want to try some runs based on estimates. Just 
be sure they don’t take the results to heart until the input data is refined. 

d. For now or forever: law vs. reality
The law intends for parties to calculate support based on current facts and circumstances, but this 
turns out to be impractical. People rarely modify support orders. So, because the order is likely 
to be lived with for a long time, it makes sense to run calculations based on things as they are 
expected to be, at least in the near future. If a party is in the process of getting a divorce or legal 
separation, it is best to run CalSupport using data as it is anticipated to be after the judgment.

e. It takes two, so read Chapter 2
Calculating support is not something a person can do entirely on their own. Eventually, informa-
tion from the other party will be needed, but what is really important is communication. Some bits 
of data need to be agreeable more than they need to be exact. Working on the data can mark the 
beginning of good communication and trust—or the end of it. From the beginning, clients need 
to think carefully how they will communicate. It will be very useful for the client to be aware of 
the information in Chapter 2 as early as possible.

f. Critical entries
All data required by CalSupport is important but some data deserves special care. 

Child care: If there are minor children, how child care is shared—expressed as a percentage—
is extremely important. How parenting will be shared requires serious thought, planning and 
discussion. This takes time and is likely to evolve over time.

Tax filing status has a big impact on the result. Make sure you understand this completely and 
can confidently assess the likely tax filing status for each party. If the parties are in the process 
of getting a divorce, you should indicate tax statuses as they will be after the divorce.

Tax deduction method.  It is usually more fair to use “Standard” for both parties in all cases. 
For more on this, see the online Glossary (Help menu) under “tax deduction method.”

Tax exemptions are valuable features of most tax returns. Pay particular attention to how many 
exemptions each party can claim. In general, where there are children and one party earns more 
than the other, both parties will be better off if the low earner releases exemptions to the high 
earner and both parties share the tax savings. Parents need to understand how cooperation pays 
in so many ways! CalSupport calculates and displays the optimum number of exemptions to 
be released on Screens 6 and Expert Entry. See the Glossary for more information.
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Getting around in CalSupport
To start CalSupport, select CalSupport PRO from the Start button on the Windows task bar, 
select Programs and navigate to the CalSupport folder where you select the CalSupport icon. You 
might want to make a shortcut of the icon for your desktop or Quick Launch.

The menu bar and left column buttons organize and control nearly all of CalSupport’s features. 
When you are in CalSupport’s basic screens (1–10), they look like this:

Preferences
Under File menu > Preferences, you can enter or change your phone number (printed on most 
reports and worksheets) and control the way CalSupport PRO handles your files. 

Saving cases: set where you want to save your case files, say in C:\CLIENTS. First create that 
folder, wherever you want to put it. If you do not specify a more convenient location, CalSupport 
PRO will save your cases in C:\Program Files\CalSupportPRO. 

Entering data
Direct entry. When in any field, just type in your data and go on to the next field by using either 
TAB, ENTER or your mouse. 

Popup entries. Buttons on entry screens indicate a popup is available. Sometimes it is purely 
informational, but for many items information can be entered only in the popup. Just click on 
the button and the popup will appear. 

Move between screens. Click a button in the left column, or use the Entry 
menu to select a screen. 

Selecting menu items:
• From any screen. Simply click on the menu you want and drag your mouse 
down the list to select the item you want, then let go. 
• From the desktop. When a menu is open (expanded so its submenu items 
are showing), you can select submenu items with your arrow keys, then 
press Enter.

Moving from field to field. 
• You can select any field with your mouse.  
• Your Tab key moves to the next field in sequence.
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time period for entries and results
For entering or viewing data, CalSupport allows you to toggle freely between various time periods 
by selecting the one you want from the Time menu. Important tip: when entering data, always 
look to make sure you are in the correct time period. Entering data in the wrong time period is 
a common source of errors.

Irregular or seasonal income or expenses should be entered as an annual figure. If necessary, 
an average can be taken over one or more years. If income is seasonal, you may want to tailor an 
agreement to require larger payments in the high season and lower payments in the low season. 
Cooperation can make life more convenient and agreeable for all parties. 

Simple cases and quick sketches
There are a lot of fields in CalSupport. You should consider all of them in every case to make 
sure nothing is left out, but the fact is that most cases will be calculated with only a few lines of 
data entry. Here are the most commonly used entry fields:

Screen 1: Enter the case title, number of children and timeshare, and the county of filing.
Screen 2: Enter gross wages, self-employment, and other significant forms of income. 
Screen 3: Enter common deductions and child care expenses, if any.
Screen 4: Enter number of children of other relationships who live with either party.
Screen 6: Enter tax status and number of exemptions that will be claimed by the parties. Be 
sure to double-check that the number of child exemptions claimed is correctly entered.

With these few fields, you will be able to get a quick sketch of a case. For many cases, these will 
be all the fields you will use. However, always check to make sure the other items have been 
considered and eliminated for every case.

Calculating support
a. Calculation options: Screen 9
The calculation options are controlled in Screen 9 and they are worth very careful consideration. 
In general, other than selecting the correct county, you should use the default options. 

Spousal support: You will usually use the spousal support formula preferred for the county 
where the case has been filed or where it is likely to be filed. The correct county may already 
have been selected on Screen 1, item 9. If not, select it at Screen 9, item 4. The correct formula 
for the selected county is automatically entered. If you want to enter a different formula, this is 
done by checking item 5 and making the desired entries. If the parties were never married or have 
agreed not to have spousal support, check item 7 for “none.” If the parties have already agreed 
to a specific amount, enter that amount at item 6 and indicate who pays it.

No child support: If you aren’t calculating child support, make sure “0” is entered for both par-
ties on Screen 1, item 5: “Number of minor children....”

b. Understanding the results: Screen 10
Screen 10 displays a summary of the calculated results.

• Guideline Support. Total support under the guidelines is displayed, broken down to show 
the component amounts of spousal support, child support and child support add-ons together 
with the way add-ons are shared. 
• Family support shows how much would be paid if a family support order is used instead 
of child and spousal support orders. It is sometimes possible to save on taxes by making all 
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or some part of child support deductible to the high earner. If so, the amount saved is shared 
between the parties. When family support works, it means that the payor pays more support 
and still has more left over to spend. 
• Net Disposable Income and Net income after support are clarified on the Net Income 
Report. Take a look.

the Expert Entry Screen
Once you are very familiar with Screens 1-10, you will do most of your work from the 
Expert Entry screen. To get to it, just click the last button in the left column. The screen looks 
like this:

Current tax year and calculation options are shown in the green header bar.  
Use the return button to jump to the basic CalSupport screens.  
The action of of this button is controlled in File > Preferences.

Enter data directly into white fields. Click on a grey field to go to the relevant CalSupport screen for entering 
other information. Thus, every CalSupport field can be accessed from this screen.

Results are shown in the pink area at the upper-right—Guideline and a comparison that you select. Analysis 
is displayed in the blue areas. Terms are defined in the Glossary. Percentage differences are shown in the 
narrow column at the right of the screen. If NM is displayed, it means that the percentage is not meaning-
ful. See page 37.

Choose 2d column results displayed
Jump to Calc Options Screen
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Monitor resolution
The Expert Entry screen requires a monitor resolution of at least 1024 x 768 to display fully. It 
is possible to view it at a lower resolution using scroll bars, but this is not nearly so convenient 
as being able to view the entire Expert Entry screen at once, as intended. 

Use your Windows Display Control Panel (Start > Settings > Control Panels > Display) to set 
monitor resolution. The Display Control Panel can also be accessed on most Windows systems 
by right-clicking on the desktop and selecting Properties. The Display control panel comes up. 
Click the Settings tab and adjust the screen resolution slider bar to set the desired monitor resolu-
tion. Caution: we have heard that some old monitors can be damaged if you try to set them to a 
resolution higher than they were intended to handle. Consult your manual.

CalSupport reports
The Reports menu shows all available CalSupport reports. They can all be viewed on screen or 
printed. Be sure your computer’s date is set correctly before you print.

• The Case Info Worksheet is a list of each item of information needed to run CalSupport. 
Print one for each party. It will help them gather and exchange accurate information that is so 
essential to calculating support accurately and reaching agreement.
• The Timeshare Worksheet lists information needed to figure timeshare. This helps parties fo-
cus their thinking about the parenting plan. If there are children, print a copy for each party.
• The Support Summary is the principal reporting and negotiating tool. It displays and clari-
fies the data entered and options selected to calculate results. It makes the point that child 
support is mandatory so that if the parties can agree on the data going in, the result coming 
out is required by law and there’s nothing to argue about. It shifts the emphasis of negotiation 
away from conflict about the amount to negotiation about the accuracy of the data used. 
• The Bench Report—Input Information (available only in the PRO version) resembles the 
Input Screen printout generated by DissoMaster. It is for judges and is submitted with divorce 
or legal separation paperwork or in case the parties end up in court on a motion. 
• The Bench Report—Support Order resembles the report generated by DissoMaster. It is 
for judges and is submitted with divorce or legal separation paperwork or in case the parties 
end up in court on a motion. 
• The Bench Report—Findings and Orders resembles the report generated by SupporTax. It 
is for judges and is submitted with divorce or legal separation paperwork or in case the parties 
end up in court on a motion. 
• The Net Income Report is a detailed illustration of how each party’s gross income is affected 
by taxes, deductions, support paid and received, and additional child-care expenses. It shows 
the net amount remaining to each party for living and other expenses.
• Additional Income Tables show the effect on guideline support of any new or additional 
income in the future that was not included on Screen 2 when you ran the calculation. If the 
parties agree, or if the court orders it, these tables can become the basis for adjusted support 
payments in the future if and when new irregular income is earned. 
• The IRS W-4 Report displays information used to fill out a party’s W-4 form, which is 
used by the employer to determine the amount of withholding deductions. 
• Tax Reports contain detailed information of interest to attorneys and accountants.
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the Glossary
This is an extremely useful and important learning tool. The Glossary defines and discusses terms 
and concepts central to child and spousal support and, of course, every term used in CalSupport. 
You can access the Glossary from the Help menu.

Back up all your work, all the time
Computers are fallible. People are fallible. If there’s one thing you can count on for sure, it’s this: 
your computer is sure to crash some day. The other thing you can count on is that it will crash 
when you haven’t backed up some work that you can’t afford to lose. Beat Mr. Murphy’s rule: 
back up all your work all the time. Then when your computer crashes or hangs up, what could 
have been a major tragedy becomes a mere pain in the butt.

To back up cases, they will be in whatever location you specified in the Files > Preferences dialog. 
If you didn’t specify a location, assuming you did not redirect the installer, they will be found 
in  C:\Program Files\CalSupportPro. Make back up copies of all your client folders to a floppy, 
removable drive or CD and keep the disk somewhere safe and away from your office.

technical support
Nolo Press Occidental provides technical support for technical problems related to the software. 
Contact Nolo if you think you have found a bug or can’t get the software to function. We espe-
cially treasure your comments and requests for features. However, Nolo’s staff cannot provide 
legal advice nor are they capable of doing so, but you can get legal advice and counseling by 
calling the attorneys at Divorce Helpline.

Legal advice
Legal advice and counseling from Divorce Helpline is available either to professionals using 
CalSupport or directly to their clients. Divorce Helpline’s experienced family law attorneys are 
mediation trained, oriented toward settlement while protecting rights, and especially good at 
finding practical solutions and explaining things in clear language.

Divorce Helpline attorneys are conveniently available by phone at reasonable rates to give you 
or your clients advice and counseling about:

• the meaning of terms
• the meaning of results
• how to find needed information
• how to get information from or about the other party
• how to talk to the other party and negotiate an agreement
• how to find and consider alternatives and options
• how to make sure the parties get all possible tax savings
• how to use the reports in court

or anything else related to child or spousal support, divorce, or legal separation. Divorce Help-
line attorneys are also available to draft marital settlement agreements. You can reach Divorce 
Helpline at (800) 359-7004. There is no charge when you call to inquire about how the Divorce 
Helpline service works.
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C H a P t E R     1
things You should knoW about thE laW
Child support and the California Guideline

This manual is specifically focused on support guidelines. Most of California’s legislation con-
cerning child support is contained in the Family Code, sections 3900 to 4203. You can find the 
Family Code at your county law library or a good reference library, or on line at www.leginfo.
ca.gov./calaw.html.

Basic concepts.
• The California child support guideline is statewide and mandatory. That means all California 
judges must follow it. 
• Both parents are mutually and equally responsible for the support of their minor children. 
• Children will be supported according to the parents’ circumstances and station in life and 
the child’s circumstances (i.e., needs).
• Each parent should contribute to the support of the children according to his or her ability. 
• The guideline takes into account each parent’s actual income and level of responsibility 
(timeshare) for the children. However, if a parent has voluntarily reduced income and suitable 
employment is available, it is possible to consider earning ability instead of actual income.
• Children should share in the standard of living of both parents. Child support may therefore 
improve the standard of living of the custodial household in order to improve the standard of 
living of the children.
• The guideline seeks to encourage fair and efficient settlement of disagreements between 
parents and seeks to minimize the need for litigation.

Duration of support. The duty of support continues until the child marries, dies, becomes self-
supporting or reaches the age of 18. If the child is in high school full-time and not self-supporting, 
support will continue to completion of 12th grade or age 19, whichever comes first. If the parents 
agree in writing, support can be ordered to age 21 or through college or training. For babies born 
to a married couple after 1989, child support can be back-dated to the date of separation. If the 
recipient of child support should die, the obligation continues because it is owed to the child.

Support for a disabled child who is unable to work can be extended as long as the disability 
lasts, no matter how old the child. 

Guideline amounts are presumed correct. The California child support guideline provides an 
exact figure for child support that is presumed to be correct. Judges can depart from the guideline 
amount only if they hear evidence and find that special circumstances exist (see below).

Shared costs: additional support. Also called “add-on support.” In addition to guideline sup-
port, both parents are responsible for certain child care expenses which they will share equally 
(50/50) unless they agree or a judge orders that they be shared in proportion to the adjusted net 
incomes of the parties. Clearly, proportional sharing is more fair. Two add-ons must be included: 
(1) child-care expenses to enable either parent to work; and (2), uninsured health-care expenses. 
Two add-ons are discretionary to the court (or agreement of the parents) and subject to the parents’ 
ability to pay: (1) special educational needs, and (2) travel expenses for a visiting parent.

New mate income. The law does not favor including new-mate income in the calculation of child 
support. The parties can agree to consider it, but a judge can consider new mate income only if 
the parent has intentionally quit work or remains unemployed or underemployed and relies on 
his/her new mate’s income to do so.
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Parents can agree to any amount of child support if they enter into a correctly worded writ-
ten agreement for child support. A sample marital settlement agreement can be found in Nolo’s 
book, How to Do Your Own Divorce. If the amount agreed to is below the guideline amount, it 
won’t be necessary to show a change of circumstances in order to get a modification of the sup-
port order up to guideline levels.

Taxes. To be claimed, a child must have a social security number. The child support exemption 
is valuable but both parents cannot claim the same child. In general, the custodial parent gets 
the deduction; the noncustodial parent can get it only if the custodial parent signs a waiver each 
year of the right to claim the exemption and a copy of that waiver is filed with the tax return of 
the noncustodial parent. Because the high-earner saves more on taxes, it is usually best if the 
high-earner takes the exemption and pays part of the tax savings to the low-earner to cover any 
extra taxes. Finally, both parents might be eligible to take child-care expense deductions and a 
dependent care tax credit. For more detailed advice, call Divorce Helpline (see Chapter 8).

Special Circumstances. A judge has discretion to depart from guideline amounts only if evidence 
is introduced in court to show that the guideline amount is unfair due to one or more of the fol-
lowing special circumstances: 

—sale of the family residence is being deferred to benefit the children, and the recipient lives 
in it with the children, and the fair rental value of the residence exceeds the mortgage, taxes 
and insurance;
—extraordinarily high income would result in an excessively high award;
—unusual circumstances exist that would cause the application of the guideline amount to be 
unjust or inappropriate;
—necessary job-related expenses beyond the authorized deductions;
—financial hardship due to expenses from extraordinary health expenses or uninsured cata-
strophic loss or care of a live-in child by another relationship;
—income of a parent’s new spouse or mate must be considered to some extent as additional 
income of the party because extraordinary circumstances exist or because the parent involved 
has voluntarily reduced income or quit working.

Evidence of any of the above special circumstances can be raised with the court or the parties 
can agree about it without going to court. You can never be sure ahead of time what a judge with 
discretion will do, so it is always better to make an agreement without going to court.

Modification. Child support orders can be modified at any time to accommodate changed cir-
cumstances, such as changes in the income or expenses of either parent, significant changes in 
cost of living, changed needs of a child or party, and so on. The parties can agree (stipulate) to 
a changed amount or it can be taken to court on the motion of either party. It is not okay for the 
parties to simply make an agreement between themselves: the court order determines how much 
is owed no matter what parties may have agreed informally. Parties must modify the court order 
if any changes are made.

Annual review. Once a year, either party to a support order can serve a request for a completed 
Income and Expense Declaration on the other party without going through the court. This will 
help decide if a motion for modification is in order. Request forms are available at the Clerk’s 
office.

 Spousal support and local guidelines
For a broader discussion of spousal support and related issues, be sure to read How to Do Your 
Own Divorce in California, Chapter 5. This manual is more specifically focused on the support 
guidelines. 
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Most counties have adopted spousal support guidelines while a few have none. Even in counties 
that claim to have no guidelines, judges are likely to use some guideline from another county as 
an aid to their thinking. Only two different spousal support guidelines are widely used around 
the state (the Santa Clara and Alameda formulas) while two or three other formulas are used in 
one or two counties at most. Chapter 6 discusses how you use CalSupport to select the correct 
spousal support guideline for your county.

Spousal support guidelines are advisory only. Unlike the child support guidelines, spousal 
support guidelines are not binding on the judge: the judge has broad discretion to make an award 
based on all the circumstances and the guideline amount is advisory only. However, most judges 
do use some guideline or other as a starting point for their thinking. You can’t predict exactly 
what amount a judge might award in a particular case but, in general, most spousal support orders 
tend to fall fairly near the guideline. Near enough that it is rarely worth fighting over. 

In deciding the amount and duration of a spousal support order, a judge is required to consider 
ten statutory factors, starting with the standard of living established during the marriage. Here is 
the language of the controlling statute:

Family Code §4320: In ordering spousal support under this part, the court shall consider all of 
the following circumstances: 
(a) The extent to which the earning capacity of each party is sufficient to maintain the standard 
of living established during the marriage, taking into account all of the following: 
 (1) The marketable skills of the supported party; the job market for those skills; the time 
and expenses required for the supported party to acquire the appropriate education or training 
to develop those skills; and the possible need for retraining or education to acquire other, more 
marketable skills or employment. 
 (2) The extent to which the supported party’s present or future earning capacity is impaired 
by periods of unemployment . . . incurred during the marriage to permit the supported party to 
devote time to domestic duties. 
(b) The extent to which the supported party contributed to the attainment of an education, train-
ing, a career position, or a license by the supporting party. 
(c) The ability to pay of the supporting party, taking into account the supporting party’s earning 
capacity, earned and unearned income, assets, and standard of living. 
(d) The needs of each party based on the standard of living established during the marriage. 
(e) The obligations and assets, including the separate property, of each party. 
(f) The duration of the marriage. 
(g) The ability of the supported party to engage in gainful employment without unduly interfering 
with the interests of dependent children in the custody of the party. 
(h) The age and health of the parties, including, but not limited to, consideration of emotional 
distress resulting from domestic violence perpetrated against the supported party by the supporting 
party where the court finds documented evidence of a history of domestic violence, as defined in 
Section 6211, against the supported party by the supporting party.
(i) The immediate and specific tax consequences to each party. 
(j) The balance of the hardships to each party. 
(k) The goal that the supported party shall be self-supporting within a reasonable period of time. 
Except in the case of a marriage of long duration as described in Section 4336, a “reasonable 
period of time” for purposes of this section generally shall be one-half the length of the marriage. 
However, nothing in this section is intended to limit the court’s discretion to order support for a 
greater or lesser length of time, based on any of the other factors listed in this section, Section 
4336, and the circumstances of the parties. 
(l) Any other factors the court determines are just and equitable.
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How long is a long marriage? Section 4336, referred to above, presumes a marriage of 10 years 
or more to be long duration, but under some circumstances a shorter marriage can be considered 
to be long, while a longer marriage with periods of separation could fail the test.  

How long does spousal support last? The parties can set any term by agreement but, when de-
cided by a judge, the duration will be related to the length of the marriage and the circumstances 
of the spouses. Cohabitation before marriage will not be considered. A rule of thumb is half the 
length of the marriage, as cited in the statute above, but note that this does not apply to long 
marriages. Unless agreed otherwise in writing, spousal support is not terminated by cohabitation 
with another party, but it automatically ends on remarriage of the recipient or the death of either 
spouse. To get support beyond the life of the payor, make life insurance part of the support agree-
ment. The parties can set the duration by agreement but, when decided by a judge, the term of 
spousal support will be related to the length of the marriage and the circumstances of the spouses. 
Cohabitation before marriage will not be considered at all. 

No support vs. termination. The amount of spousal support can stay steady, go down over time, 
or be set at zero. But there is a big difference between zero support and terminating all right to 
it. “Terminating” means to end the court’s jurisdiction (power) over the subject. So long as the 
court keeps jurisdiction over spousal support, the issue is still alive—a spouse can come back to 
court later to ask for a modification of the original order. Even if support was ordered to end on 
a certain date, if a motion is made before that date it can extend the term on a showing of need.

Jurisdiction. Courts should not retain jurisdiction over spousal support where the marriage was 
short and the spouses are in good health and self-supporting. For “long” marriages, the court must 
retain jurisdiction indefinitely unless the parties have agreed otherwise in a technically correct 
writing. What’s long? A marriage of ten years or more is long by legal definition, but shorter mar-
riages can be considered long, depending on circumstances. In fact, depending on circumstances, 
the judge might be willing to retain jurisdiction—for a while—over spousal support in marriages 
of only four or six years, especially if the recipient is not well or not self-sufficient. 

Modification. During the term of spousal support, an order can be modified if the recipient’s 
needs were not met by the original order and the payer’s ability to pay has increased. However, 
spouses can specify in their written agreement that the amount can’t be modified, or that the 
time can’t be extended, or both. In fact, making an agreement is almost the only way one can be 
completely certain that spousal support will stay fixed at a certain amount or end on a certain day 
or condition. If parties do agree to make changes, they must modify the original court order.

Termination. To end forever all right to spousal support—that is, to terminate the jurisdiction 
of the court to make orders on the subject in the future—it must be waived in open court or in a 
written agreement. For long marriages (even some medium ones) a waiver or a written termina-
tion will not be approved if it isn’t made clear that both spouses know that a judge would retain 
jurisdiction if asked to and that both spouses are capable of supporting themselves.

Family support: saving on taxes
For income tax purposes, child support is not deductible as an expense by the payor nor is it 
included as income by the recipient. Spousal support is deductible by the payor and is included 
as unearned income by the recipient. Family support, also called unallocated support, is an order 
for combined child and spousal support, lumped together in one sum. It is all tax deductible to 
the paying spouse and included in taxable income to the receiving spouse. This can result in extra 
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tax savings when the payor earns significantly more than the recipient. Using CalSupport, you 
can see if there is any benefit in the case to using family support. The Support Summary (Screen 
10), upper right, shows the net spendable incomes of both parties, first under the guideline and 
then using family support. If the family will end up with significantly more spendable income 
by using family support, consider using it. A family support order is permitted if tax savings 
are included in the support calculation. Parties should definitely get legal advice and assistance 
if they are going to use the family support order because: a) if it is not drafted correctly, the 
tax deduction for the entire amount of support can easily be lost; b) if they are not careful with 
tax returns and in W-4 withholding allowances, the payor can lose the advantage of the family 
support order; and c) parties should have more personalized tax advice than they can get from 
CalSupport. Call Divorce Helpline or see a local tax specialist.

The right to know: share all information, or else!
Discovery. Parties have the right to see each other’s pay stubs, tax returns, and relevant books 
and records. The law calls this “discovery.” If one party refuses to cooperate and the other is 
forced to use an attorney to get information, a judge can punish unreasonable lack of cooperation 
and order payment of attorney fees and costs as well as delivery of the requested information. 
It’s a lot cheaper to just exchange information and documents voluntarily; it’s the law; it’s the 
right thing to do.

Disclosure: If the case involves a divorce, legal separation or nullity, the law requires the par-
ties to make full disclosure to each other of all relevant information, under oath, on court forms, 
including completed Income and Expense forms. There are built-in penalties for failure to deliver 
relevant information. See How to Do Your Own Divorce in California, chapter 14, for more on 
disclosure. 

Common good sense: What one wants—more than being “right” or getting their way or getting 
even; more than anything—is to get a fair settlement of this support issue (and all other issues) 
without having to go through the horror and horrendous cost of a legal battle. This means a party 
wants to give the other party open access to all information and records they have a right to anyway 
because doing so will lay the foundation for trust, good communication and successful negotiation. 
Not doing it will surely drive the case into legal and personal conflict. Not doing it will expose a 
party to possibly having to pay the other party’s lawyer fees for taking the case to court.

The cost of not reaching an agreement
The law is often useful as a guide but rarely at settling disagreements. It can easily cost forty 
to one hundred thousand dollars to get lawyers and go to court. And—unless there are unusual 
circumstances—chances are a party will end up relatively near the guideline amounts anyway. 
Consider how much a party would have to win, if they do win, in order to regain that kind of 
money, even over ten or twenty years. It is best to seek compromise near the guideline.
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C H a P t E R     2
dEaling With thE othEr partY

If success means reaching an agreement that is fair and mutually acceptable, then very little can 
be more important than the way you and the other party interact as you try to deal with your 
issues. In this chapter we sketch some of the things you can do to help make things smooth and 
keep them that way. Nolo’s book, Divorce Solutions: How to make any divorce better, goes into 
these matters at greater length, so if communicating with the other party becomes a problem, be 
sure to read it. Meanwhile, here are some highlights, adapted and condensed for CalSupport.

Advantages of agreement
In the last chapter, we raised the frightening (but true) picture of what can happen if inability to 
agree forces you into court. The cost of not agreeing is just too high in both financial and emo-
tional terms. But, more than simply avoiding something awful, reaching an agreement has many 
outstanding positive advantages:
 • you can reduce or eliminate your involvement with lawyers and courts;
 • you will save a lot of money on lawyers’ fees;

• you get to keep control over your own case and your life;
• it is more likely that payments will be made in full and on time;
• you will feel better faster and get on with your life sooner; and
• if you have children, the parenting relationship will be smoother and healthier for the chil-
dren and the parents.

Sounds wonderful, doesn’t it? So why don’t you two just sit down and work it out? Easier to say 
than do, as you already know, but exactly why is it so difficult?

Obstacles to agreement
There are four good reasons why it’s hard for people to work out an agreement:

• emotional upset, especially that dynamic duo, anger and fear;
• ignorance and misinformation;
• the legal system and lawyers; and
• an honest difference of opinion.

To get an agreement, in or out of the legal system, with or without an attorney, you have to 
overcome these obstacles. 

Emotional upset may be the major obstacle to agreement. Pay special attention to anger, insecu-
rity and fear because these are the forces that drive people into lawyers’ offices and deeper into 
conflict. Fueling the emotional fires are such things as:

• stress of change, fear of the unknown;
• historical habits, old patterns of conflict or poor communication;
• particular events (new lover, new bills, and the like);
• fear that there won’t be enough to live on;
• fear that the parent-child relationship is going to be impaired;
• imbalance when one party has the advantage of more business experience.

You can’t negotiate when one party is wound up in anger, upset, or fear. When emotions run 
high, reason is at its lowest ebb and efforts to be reasonable will, at best, not be effective at that 
time. The best thing you can do is be a good listener; show by your words and actions that you 
understand; don’t respond, don’t defend, don’t argue or reject or belittle the emotions. The least 
you can do is walk quietly away and wait.
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Ignorance about the legal system and the rules of support can make a person insecure and inca-
pable of making a decision. They’ll feel like they don’t know what they are doing....and they’ll 
be right! Misinformation is when the things you think you know are wrong; it’s what you hear 
from friends or get from magazines or TV. It distorts your expectations about your rights and 
what’s fair. It is hard to negotiate with someone who has mistaken ideas about what the rules 
are. Fortunately, both misinformation and ignorance can be fixed with reliable information, such 
as what you get from reading this manual, talking to a local family law specialist attorney, or 
calling Divorce Helpline.

The legal system and lawyers are a major cause of conflict and an important obstacle to getting 
an agreement. This subject is discussed at length in Divorce Solutions, but we can sum it up this 
way: the legal system is based on a conflict model and has very few tools for settlement. Use a 
lawyer for information and advice if you like but don’t retain one—that is, let the attorney “take” 
your case—unless you have no other choice. A retained attorney, even one who means well, is 
more likely to cause problems than solve them. You can call Divorce Helpline attorneys if you 
want safe, expert legal information and practical settlement-oriented advice. You don’t retain 
them; they won’t let you; they are exclusively a settlement service. Call (800) 359-7004. It costs 
nothing to call and ask for more information about their unique service.

An honest difference of opinion arises when two people have different needs and interests that 
lead to the real issues of your case. After dealing with the other obstacles to agreement, your real 
issues may turn out to be relatively minor, but even if serious they can be negotiated rationally. 
CalSupport will be a great help at this level.

Thirteen tips for overcoming the obstacles
The solutions are in your hands. Apart from the legal system, which you can avoid, the obstacles 
are all personal: something between you and the other party and between you and yourself. Lawyers 
and the legal system have very little to offer compared with the potential for harm and especially 
compared with all the things you can do for yourself. And there is a lot you can do yourself.

A little good information can go a long way: if you follow our advice, you will be highly re-
warded. This isn’t to say it won’t take effort, time and patience, but you can definitely do it. If 
your relationship is seriously conflicted, or if you just want to read much more on the subject, 
get our book Divorce Solutions.

1. Insulate and protect children
Involving children in their parents’ dispute will harm them. Children need both parents and the 
parents need as much help as they can get with raising children. Let them know they are loved 
and wanted by both parents and that you will always be their mother and father, no matter what 
happens between you. Help them understand that loving the other parent is not a betrayal of you; 
they should never have to choose sides. Help them establish a pattern of stability. Help them have 
as much positive contact as possible with both parents. Tell them the truth in simple terms they 
can understand, but don’t discuss your problems in front of them; don’t pass messages through 
them; don’t let them hear you criticize their other parent. 

2. Slow down, be patient
It will take some time to work things out, reach understanding, make an agreement. It takes time 
to let emotions settle and for conflicts to resolve. Meanwhile, if you can make your situation safe 
and stable—just for a while—you don’t have to be in a hurry. Being in a hurry creates pressure 
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and increases the opportunities for upset. It is to the advantage of both parties to help each other 
get safe and settled.

3. Make preliminary agreements
Start by agreeing that you want a fair result and will both act fairly. Agree to communicate be-
fore doing anything that will affect the other party, the estate, or the children. Try to work out a 
temporary financial arrangement to help keep things stable while you work toward a final agree-
ment. You can’t negotiate when one of you doesn’t know where money will come from to pay 
the next rent or grocery bill.

4. Get information and advice
• Learn about the rules and how things work. Organize your information and start gathering more. 
Be very careful where you get advice. Your friends and relatives will give you plenty, but don’t 
take it! They may mean well but they probably don’t know what they are talking about. Take 
advice only from this manual or from an attorney who specializes in divorce, or call Divorce 
Helpline.
• It’s not enough for one party to have reliable information; it is infinitely better if you both have 
it. Get the other party a copy of this material and, if possible, discuss parts of it together. Let the 
ideas come from CalSupport, not you. Talk about how you feel about what it says in here and 
how to put these ideas to work for you. Talk about how you are going to proceed next.

5. Be businesslike
This is an important financial transaction; treat it like one. 
•  Keep business and personal matters separate. You can talk about personal matters any time, 
but never discuss business without an appointment and an agenda. This is so you can both be 
prepared and emotionally composed. No surprises.
•  Meet on neutral ground. Find a neutral place to meet, not the home or office of either party. 
The person visiting could feel at some disadvantage and the person whose home it is can’t get 
up and go if things get out of hand. Try a restaurant, the park, borrow a meeting space or rent 
one if necessary. 
•  Act businesslike. Be on time and dress for business. Don’t socialize and don’t drink; it impairs 
your judgment. 
•  Be prepared. Get familiar with the facts and how things work. Bring all relevant documents. 
Try to understand your respective emotions and past patterns so you can avoid old traps. Just 
trying to do this will help make things a little better. 
•  Be polite and insist on reasonable manners in return. If things start to sneak into the per-
sonal or become un-businesslike, say you’re going to stop if the meeting doesn’t get back on a 
business track. Offer to meet another time to discuss personal matters. Ask to set another date to 
discuss business if now is not a good time. If matters don’t improve, don’t argue, don’t get mad, 
just get up and go.

6. Share information openly
Exchange all information, records and documents freely and openly. This will help build trust and 
confidence. Besides, it’s the law—you have to do it. Be sure to read the last two pages of Chapter 
1 on this point. If one party refuses to cooperate and the other is forced to use an attorney to get 
information, a judge can punish unreasonable lack of cooperation and order payment of attorney 
fees and costs as well as delivery of the requested information. It’s a lot cheaper to just exchange 
information and documents voluntarily.
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7. Stick to the facts
Don’t discuss how much support should be, how much you want or are willing to pay. Always let 
CalSupport do that job. Stick to the much simpler matter of verifying the figures that get entered 
into the calculation. All you have to do is show each other documents to establish the correct 
amounts of income and expenses on both sides and CalSupport will settle “how much.” Because 
of guidelines, it is much easier to get an agreement than ever before.

8. Build agreement
• Try to agree on the basic facts first. Be clear about the difference between facts that can be 
backed up with records, “discretionary” items that have to be agreed on even after being proved 
with records, and options and choices that have to be agreed. The parenting arrangement, for 
one example, is something that requires much thought and agreement before it can be entered in 
a calculation as a reliable figure.
• Make a list of the facts and decisions you can agree on. Write them down. This is how you build 
a foundation for agreement. Next, write down things you don’t agree on, always trying to refine 
your differences—to make them more and more clear and precise. Try to resolve differences with 
research and documents. Compromise: if you can’t prove or justify some fact or option to each 
other, you might have a hard time doing it in court.

9. Discuss needs and interests, not positions
A position is a stand on a final outcome: “I want $800 a month and the children every weekend.” 
It is better and more effective to think and talk about needs and interests. These are more basic 
concerns: “I want what’s fair and what the rules say is mine; I need to be secure and have enough 
to live on; I want to know what I can count on for living expenses; I want maximum contact with 
my children; I need to get out of debt, especially on the credit cards; I want an end to argument 
and upset.” Put this way, these are goals that you and the other party can discuss together. 

10. Balance the negotiating power
• If you feel insecure, become informed, be well prepared, use an agenda, get expert advice and 
guidance. There’s never any need to respond on the spot: state your ideas, listen to the other 
party, then think about it until the next meeting. Get advice if you need it; use friends for moral 
support and venting; then go back in there. Don’t meet if you are not calm; don’t continue if the 
meeting doesn’t stay businesslike. Consider using a professional mediator.
• If you are the stronger person, help build the other party’s confidence so he or she can negoti-
ate competently and make decisions. Share all information openly. Be a good listener: restate 
what the other party says to show you heard it; don’t respond immediately to the other party’s 
points—say you’ll think about it. Tone yourself back: state your own points clearly but don’t try 
to persuade or “win” a point. Don’t argue or repeat yourself. Listen, listen, listen.

11. Get help
Negotiating with someone you were once close to is not easy; you’re dealing with old habits, 
raw wounds, entrenched personality patterns—all the obstacles to agreement all at once. A third 
person can really help keep things in focus. Mediators are professionals who are specially trained 
to help you negotiate; they are expert at helping couples get unblocked and into an agreement. 
Mediation is very effective and it usually goes quickly. You can call Divorce Helpline for help 
with your negotiation; it’s one of the things they do best. 
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12. After you agree
Chances are very good that you can work things out by using the techniques discussed here. Once 
you have reached an agreement, all that’s left is to get it drafted in legally correct form and then 
go through some red tape and paperwork to get your Judgment. Read about how to do this in 
Nolo’s book, How to Do Your Own Divorce. 

13. If you can’t agree
If you find that working by yourself on getting an agreement isn’t working out, don’t struggle too 
long; don’t wait until you are both at war from entrenched positions; don’t get frustrated; don’t 
get depressed; don’t get mad—get help. Call Divorce Helpline or a local family law attorney 
who works exclusively as a mediator. 

If you have children and cannot agree about custody arrangements, a court will refer you to man-
datory mediation. This is usually very effective and costs nothing but your time in most cases. 
Try this if your own negotiations fail.

Comparing results with other programs
Sometimes one of the parties gets a computer printout from DissoMaster™, SupporTax™ or some 
other program—maybe even CalSupport—with a different result. Of course, you both want to 
know what happened.

1. Check the data: This is the most common cause of differences, either because different data 
was used or the same data was entered differently. You have to compare the data that was input 
into each program very, very carefully. 

CalSupport™ has more entry fields than other programs and each field is specifically de-
fined. In other programs, it might take a trained professional to determine what data goes 
into which field, and several items of data might be combined and entered into one field. 
DissoMaster™: Get page 1 of the “Formal Report” and the “Input Screen” printout. Compare 
with CalSupport’s Support Summary Report. Also ask for the “Settings” printout.
SupporTax™: Get the All-Input Report, which shows every data item and all options. 
Compare with CalSupport’s Support Summary Report. 

2. Check the settings: If different calculation options were used, or if the calculation was based 
on a different tax year, you can expect different results. Make sure both programs were current 
and used tax tables for the same year.

DissoMaster™ has many technical options reported on two screens.

• On the “Input Screen” printout, check the tax year (upper left corner), date of the report (lower 
right corner), and the Tactic used to generate “Proposed Results” (Family Support). Tactics 8b 
and 8f are most like CalSupport. Tactic 8b allows two-way payments. CalSupport allows two-way 
payments only if the guideline support specifies two-way payments (when child support is owed 
to one party and spousal support is owed to the other). If tactics 1–7 were used, this means the 
user fixed the results by setting a parameter for the outcome. Ask the other party to go back and 
get a report based on tactics 8b and 8f and negotiate away any differences. 

For example, DissoMaster tactic 8b might take a $1000 child support and $1000 spousal sup-
port payments from Dad to Mom and turn that into a $3000 family support payment to Mom 
and a $800 child support payment to Dad. This smacks of tax evasion since the only reason for 
the two-way payments is to avoid paying taxes. CalSupport will at most make a $2000+ FS/CS 
payment to Mom but no payment from Mom to Dad. However, if the guidelines call for a $1000 
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spousal support payment to Dad and a $1000 child support payment to Mom, CalSupport will 
explore between these limits for the best family/child support structure. So it might find that a 
$600 family support payment to Dad and a $500 child support payment to Mom is the payment 
structure with the lowest taxes. It really has to be that way or the best family support solution will 
generally be worse than the guideline support solution. However since the guidelines originally 
specified a two-way payment, the IRS cannot argue that the parties have deliberately structured 
their deal just to avoid paying taxes.

• You want to see the first page of the “Settings” printout. Pay special attention to the State and 
Federal tax credits to see if any were included in one program but not the other. For example, 
DissoMaster blocks the California Renter’s Credit only if the party is paying property tax, and 
this is not always the correct choice. 

SupporTax™ reports the tax year and calculation options in the All-Input Report. SupporTax 
refers to family support as “optimized” support.

3. If the data and options check out: If all data checks out, the same options were used in both 
cases, and the same tax year was calculated, then there should be very little difference between 
results produced for child support. In some cases, DissoMaster can produce small differences, 
especially in higher income ranges, due to technical differences in the way the programs treat 
taxes. Small differences can be negotiated. Large differences are probably due to entry error or 
different options having been used in DissoMaster or differences in the inclusion or exclusion 
of tax credits.

DissoMaster’s differences. There are three things that DissoMaster does differently from Cal-
Support and SupporTax that can sometimes account for different results:

1) DissoMaster allows authorized deductions to be greater than a party’s net disposable income 
(NDI), but we believe that is a misinterpretation of the intent of the statute so do not allow 
deductions greater than NDI.
2) DissoMaster applies certain tax credits automatically and requires an override if you don’t 
claim one or another of them. Sometimes this can introduce an error.
3) We have seen cases where it appears that DissoMaster allows a hardship deduction for live-in 
children of other parties even when the parties themselves have no minor children. This is not 
permitted by any case or statute. Following the law, CalSupport limits the hardship deduction 
to child support actually paid, so if none is paid, there is no deduction. This is something you 
should check carefully when comparing results.

DissoMaster spousal support error. In some situations, DissoMaster can produce a noticeable 
difference in spousal support which also shows up in the Family Support result. We believe Dis-
soMaster contains an error in the way they distribute tax savings from the payor’s deduction of 
spousal support payments. DissoMaster allows the recipient’s share, bottom line, to fall below 
the amount specified in the formulas. 

DissoMaster is popular among many judges and lawyers, so you can’t simply disregard it. This 
simply means you are left with one more item on your list of things to negotiate. Compromise; 
this isn’t worth fighting over.

Get advice
If you find all this confusing, you aren’t alone. Many judges and attorneys find it difficult to track 
down and understand these differences. If you want some expert advice and ideas about how to 
handle your situation, talk to a family law attorney, or call Divorce Helpline (800) 359-7004. 
For a reasonable charge, their attorneys will help you understand your case and look for practical 
solutions that will lead you to a fair settlement. 
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C H a P t E R     3
gathEring nEcEssarY information

Everything depends on having accurate information—the data you enter into CalSupport. The 
client will know some of this data or can quickly find it out, some they may decide to estimate, 
and some may have to be developed or worked out over a period of time. In this chapter, we 
discuss the nature of data, how to gather it, and how to get data from the other party.

Built-in data assistance
Extensive help screens. CalSupport has help information for each item appearing in the TIPS 
window at the bottom of each standard entry screen. One way to get familiar with the data is 
to go through CalSupport screen by screen and read the help menus and whatever popups may 
appear for some items.

Glossary of Terms. CalSupport has a comprehensive Glossary of Terms that you can view on 
screen or print. Access it from the Reports menu. If you want more information on an item than 
appears in the TIPS window on each screen, first look in the Glossary then in this manual. 

Information Worksheets. CalSupport provides two convenient worksheets that list every item of 
information needed to run a calculation. The Case Info Worksheet and the Timeshare Worksheet 
are located under the Reports menu. You can give the client a copy of each (and a copy for the 
other party) but don’t deliver them until you discuss the concepts in Chapter 2.

tips about the data
a. Precise data vs. estimates
CalSupport is, among other things, a calculation engine. To get accurate results, you need to enter 
accurate data. The result is only as accurate as the data, so if you enter estimates or guesses, you 
will dilute the accuracy of the answer. Professional data analysts call this the GIGO principle: 
“Garbage In, Garbage Out.” 

On the other hand, things fluctuate and change, and data can take time to gather, especially from 
the other party. So what to do? Because it will take some time to gather precise data, the client 
might want to try a run based on estimates. CalSupport is a learning experience and a process. It’s 
not expected that anyone will just sit down, plug in the data and come away with the final solu-
tion. It takes time. Meanwhile, be sure the client keeps the GIGO principle in mind and doesn’t 
take results completely to heart until the input data is completely thought out and refined. 

b. For now or forever? Law vs. reality
The law intends for people to calculate support based on current facts and circumstances. Later, 
when things change, the law expects them to come back to court and get the order modified. 
This approach has the advantage of using existing facts that are capable of proof. You can look 
at current pay stubs, tax returns, books and records and prove almost exactly what someone’s 
income and expenses are right now. But, in some important ways, this approach is impractical 
and unrealistic; more for some people than others. 

In practice, people hardly ever modify support orders. Because the order they get is likely to 
be the one they live with for a long time, it makes sense to run calculations based on things as 
they are expected to be, at least for the near future. If the party is heading for a divorce or legal 
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separation, it makes particular sense to run things as they will be after the judgment has been 
entered. The tax filing status, for example, has a big influence on the result and it will almost 
certainly be different after a divorce or legal separation.

Estimating future conditions means the client needs a higher degree of cooperation and under-
standing from the other party because what they are really after, ultimately, is the other party’s 
agreement that the facts entered in CalSupport are reasonable. If the client is experiencing a high 
degree of conflict or suspicion, stick to facts that can be backed up with documents and send the 
documents along with the printed Support Summary report. 

Tell the client very firmly to keep all discussion focused on the facts; let CalSupport state the 
conclusions.

c. Authorized vs. discretionary items
Authorized and discretionary items are clearly marked in CalSupport. 

Authorized means that the law says these items will be included in the calculation so the only issue 
is proving the amount; if you have records to show the amount, that amount will be included. 

Discretionary items should also be documented, but they still won’t be included unless the parties 
agree that it is fair to include them or evidence is presented in court and a judge decides that it 
is fair and appropriate to include them. 

d. Critical entries
All data required by CalSupport is important but some data deserves special care. Be sure you 
study the help screens and the Glossary for each item and make sure the client understands the 
meaning of each item of data.

Child care and timeshare. If there are minor children, the client has to make some decisions 
or assumptions about how much time during a typical year each parent will have the physical 
care of the children, expressed as a timeshare percentage. Specifically, you need know which 
parent will be designated as having the primary physical care of the child and what percentage 
of time the other parent will have primary responsibility for the child. How parenting will be 
shared requires serious thought, planning and discussion. 

Tax filing status has a very big impact on the result. Make sure the client understands this 
point completely and can confidently indicate the likely tax filing status for each party. If the 
client is in the process of getting a separation or divorce, indicate the tax filing statuses as they 
will be after the judgment is entered.

Tax exemptions are valuable on most tax returns. In general, if there are minor children and 
one party earns more than the other, both parties will be better off if the low earner releases 
exemptions to the high earner and both parties share the tax savings—but not always; it de-
pends on all the other factors. CalSupport calculates the optimum use of exemption releases 
and reports this on Screens 6 and Expert Entry. Point out to the client how much tax money 
can be saved and shared if parents can cooperate.

Tax deduction method might or might not have a big impact. You have to experiment to find 
out. Many attorneys believe that the fairest way to figure support is to use the standard deduction 
method for both spouses. This is because a person who has high expenses pays less taxes, so 
has more left over to pay for support. They think it unfair that higher expenses should result in 
higher support. For example, why should tithing to your church or straining to put more away 
for retirement, or paying into a high mortgage mean that you pay more support? On the other 
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hand, the recipient would probably rather insist on the accurate calculation of tax savings in 
order to get more support, as required by law. It’s a subject for negotiation.

Gathering information
Start with the information worksheets
CalSupport provides two handy worksheets to help the client gather information. Under the 
Reports menu you will find the Case Info Worksheet that lists all necessary income and expense 
information and the Timeshare Worksheet that lists information about the planned parenting ar-
rangements so you can calculate (estimate) timeshare. Print copies of the worksheets for the client 
and the other party, but tell the client not to deliver worksheets to the other parent until you have 
discussed the concepts in Chapter 2 or have given the client a copy of Chapter 2 to study.

Where to look for data
Family information, Screen 1. It isn’t hard to figure out how many minor children the parties 
have, but it will take careful thinking, discussion, and time to decide exactly how parenting will 
be arranged. First, the client should do his or her own thinking with the help of the Timeshare 
Worksheet. Advise the client not to start talking to the other parent about it until you have dis-
cussed the conflict resolution ideas described in Chapter 2.

Income and deductions, Screens 2-5. Basic income and deduction expenses are found on pay 
stubs and in tax returns. Self-employment information is found in books and records, statements 
from accountants, and tax returns. Interest and dividend income will be found on the statements 
from the institution that manages the account. Child care and other expenses can only be docu-
mented by receipts or canceled checks showing payment.

Tax status, screen 6. Tax filing status of the parties after divorce or separation is an important 
choice that can make a very big difference to the tax bill in some cases. Be sure to read the Glos-
sary on this point. If there’s still any confusion about it, the client should consult a tax accountant 
or call Divorce Helpline before deciding on tax status. 

Tax deduction information, screens 6 and 7. This information is available in old tax returns 
and current books and records.

How to get information from the other party
Unless the parties are on good solid ground, don’t even think about contacting the other party for 
information before discussing the ideas in Chapter 2. Keep in mind that the goal is to develop data 
entries that both parties can accept. This means that the client’s first goal is to build a foundation 
of trust and avoid doing anything that might undermine it. 

Start slowly
Which party wants to settle the matter of support? Call that person the initiator. It is very com-
mon for one party to take care of business while the other party is at best passive and at worst 
resistant. Typically, the initiator will be the first person to read Chapter 2. The initiator has already 
thought things over and reached at least tentative conclusions, while the other party may not have 
given the matter much thought yet. It is important not to pressure them; don’t jump them with 
well-reasoned conclusions and get frustrated when they don’t go along. The client can go as fast 
as the other party will tolerate, but should slow down at the first sign of resistance and give the 
other party time to catch up. 
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In the beginning: information and advice
It is always best to begin by putting information in the other party’s hands. If the client can 
afford it, have them buy the other party their own CalSupport program to use. The other party 
should also have a copy of Divorce Solutions (even if you’re not in a divorce situation,  this 
book has lots of information about resolving conflicts). If there is a divorce in the picture, the 
parties should each have copies of How to Do Your Own Divorce. Reliable information is often 
all it takes to cure insecurity, fear and upset. Suggest the parties begin by discussing topics that 
are in these materials. If anyone has a point to make, let it come from the books or software as 
often as possible. 

Encourage each party to get reliable advice by calling Divorce Helpline or consulting a local 
family law attorney who specializes in mediation. Where children are involved, most counties 
have court mediators who may be able to help resolve custody and support disagreements.

Focus on the data, use the worksheets
Advise the parties not to get involved with how much support one person wants and how much 
the other wants to pay; let CalSupport say how much is fair. Keep discussions focused on the data 
that gets entered. Give the other party a copy of the Case Info Worksheet. If there are children, 
also use the Timeshare Worksheet. These can be found under the Reports menu.

The next step is to exchange completed worksheets and documents to support the numbers that 
each party enters. Suggest the parties try to agree on a date for the exchange of worksheets and 
documents. Even if the other party doesn’t comply, advise the client to send his or her own in-
formation on time; further requests for information will work better that way.

Self-help
If the parties were married or shared joint accounts, the client may have access to more informa-
tion about the other party than he/she realizes. Joint tax returns belong to both parties; if copies 
of past joint returns are not in hand, they can be obtained from the accountant who prepared 
the returns or copies of returns can be ordered from the IRS. Contact your local IRS office for 
information. The same is true for joint bank or credit card or trading accounts: a party has a right 
to copies from the institutions who manage any accounts under joint names.

If you can’t get cooperation
Once it becomes clear that the other party is not going to give up information, go ahead and run 
CalSupport with the client’s best estimate of what the figures and options should be. Take every 
doubt and uncertainty to the client’s advantage. Send a Support Summary Report to the other party 
with a letter telling them this is the amount of support that should be paid in your case according 
to the guidelines. Ask if they have any comments about the data entered; if so, please provide 
correct information, otherwise the case will proceed on the basis of the data as entered.

 If this doesn’t get a response, send copies or call attention to the sections in this manual and in 
How to Do Your Own Divorce where it states that discovery and disclosure are required by law and 
where it states that there are penalties for not complying. Copies of such letters should be kept.

If you want help, get legal advice. Call Divorce Helpline or a local family law attorney.
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C H a P t E R       4
sEtup and opEration of calsupport

We assume that you have a basic familiarity with Windows. Even if you are a beginner, you will 
have no trouble using CalSupport because it’s so easy and intuitive.

Computer setup
IMPORTANT! The current date appears on all reports, so it is extremely important that your 
computer be set to the correct date when you operate CalSupport.

To install CalSupport. If downloaded or on a CD, simply double-click on the installer icon. Most 
people would do best to let CalSupport install without changing the default settings. 

To start CalSupport, click the Start button on the task bar, select Programs, find the CalSupport 
PRO folder, and select CalSupport PRO.

Network operation
If CalSupport PRO is being used on more than one computer on a network, you need to install 
it separately on each computer. However, by using File > Preferences, you can set the location 
where each CalSupport PRO saves cases so that all cases are saved and kept on one machine. 
This makes it easier to manage the backing up of case files for the whole company. 

the menu bar
The menu bar, at the top of most screens, and the buttons in the left column, operate CalSupport’s 
features. The CalSupport Menus and respective submenu items are displayed on the next page.

You can select menu items with your mouse or from the keyboard:

Fig. 4-1: Screen 1—menu bar and case description

Name of file (variation) Name of client’s directory
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• With a mouse. Select a menu or submenu item with your mouse. 

• Keyboard. Press ALT plus the first letter of whichever menu you want, then press the under-
lined letter in the name of the submenu item you want or, in the Entry menu, use the number of 
the screen. You can also scroll to the item you want with your arrow keys and press ENTER. 
Change from one menu to another with left or right arrow keys. When menus are closed—that 
is, no submenus are showing—you can move to another menu item simply by typing the first 
letter of whichever heading you want. 

Fig. 4-2: Menu  items

ENTRY MENU
From this menu, you can select or change the active 
entry screen.

REPORTS MENU
From this menu, you can select the Report Selector, or 
the reports to be viewed or printed, including the blank 
Case Info and Timeshare Worksheets.

WINDOW MENU
Choose the arrangement of open windows, or select 
the window to be made active (on top). This one is best 
left alone.

HELP MENU
Glossary: Definitions and explanations for all terms used 

in CalSupport.
Overview: Displays the initial (startup) help screen.
Help Topics: Displays the contents and index for the 

Help files.
Comparing To Other Programs: Clarifies comparisons 

with DissoMaster, identifies some quirks and errors in 
DissoMaster 2002, methods to match results. 

Check For Updates: One-button operation to go online 
and check for latest version. Automatic or manual.

Tech Support: Displays link to Web site Bug Report 
form and a form you can use to fill out and print a Bug 
Report to fax or mail.

Comments, Suggestions: Contacts for sending us your 
feedback.

License Agreement: Displays the CalSupport License 
Agreement.

About: Displays information about CalSupport, the reg-
istered user, and those who get the credit  (or blame) 
for the CalSupport software.

FILE MENU
New: Opens a blank file with your default options.
Open: Opens an existing file. Several can be opened.
Close: Closes the currently active file.
Save: Saves the current file.
Save As: Saves current file under a new name.
Print setup: Windows printer chooser.
Preferences:

Phone number: Appears on reports along with your 
company name.
Prefer PDF: Saves reports in PDF format when 
selected from Reports menu.
Startup case: Start up CalSupport with last case or 
new (blank) case.
Startup screen: Specifies the first screen to ap-
pear when you open a new file.
Return From Expert To: Controls action of Return 
button on Expert Entry Screen. Go to: Last Screen 
Visited, Screen 1 or Screen 10.
New case options:

Time Mode: Specifies time period for new files.
County: Specifies the county of filing to be 
auto-entered for new files.

Apply Tax Credits: When checked, all applicable tax 
credits are auto-selected  if there are children.
Default Data Path: Specifies where to save cases.
Tax Year: Select a different  tax year for the case 
you are working on. New cases will always start with 
the current tax year.
Uneven Allocation Method applies CalSupport’s 
more fair method rather than the default method that 
emulates DissoMaster. Read the Help file for more.

TIME MENU
Select the time period for entry and display of all fields 
and results: annually, monthly, bimonthly, semiweekly, 
weekly, and year-to-date. 
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Customizing CalSupport PRO
The File > Preferences submenu controls the way CalSupport PRO functions. When you first 
open CalSupport, you should set up these elements:

•  Phone number. Check to verify that your phone number is correct.

•  Prefer PDF. Check this if you typically want to save reports in PDF format when selected 
in the Report Selector or Reports menu. You can still print them from the Report Selec-
tor.

•  Startup case. Controls the screen you see when you start CalSupport. 

•  Startup screen. Controls the screen that appears when you first open a file. If you are new 
to CalSupport, you probably want this to be Screen 1. Once you are completely familiar 
with CalSupport, you will probably want your files to open on the Expert Entry screen.

•  Return from Expert to. Sets the behavior of the return button on the Expert screen.

•  New Case Options. Set this so every new file you open will be set to the time mode you 
use most (probably Monthly) and the county in which most of your cases will be filed. 

•  Apply tax credits. Uncheck this box if you do not want CalSuport to automatically select 
all applicable tax credits when children are entered on Screen 1.

 •  Tax year. Applies only to a case you are working on. New (blank) cases will always open 
set to use the current tax year.

Getting around in CalSupport PRO
Moving from screen to screen 

• Tabs. You can get to any CalSupport screen by clicking on the large buttons in the left 
column.
• Entry menu. Select any screen from the Entry menu. Use your mouse or ALT-E.
• Keyboard. You can move to the next screen in order by pressing the Page Down key or to 
the previous screen by pressing the Page Up key.

Moving from field to field
The TAB or RETURN keys move to the next field in sequence or you can select any field with 
your mouse. Arrow keys move the cursor inside of a field.

Entering information
Direct entry. Just type in your data and go on to the next field. 

Popup entries.  Fields with data popups have a green button next to the field. Click on the green 
button to bring up the popup.

time periods
CalSupport allows you to view and enter data in various time periods: annually, monthly, bimonthly, 
semimonthly, weekly, and year-to-date. You can change the time period at any time by selecting 
it from the Time menu. All CalSupport screens and reports switch to whatever time period you 
choose and the data on all screens is fluidly converted. 

tips window
Each field of each data entry screen has its own definition or tips in the TIPS window at the bottom 
of each screen. The TIPS appear automatically. Some fields have popups with more information. 
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If you want still more information, look first in the Glossary and then in this manual.

How to manage your files
Saving cases and variations
CalSupport PRO creates a directory for every different client and puts each variation in that 
directory. Client directories are kept wherever you designate in the File > Preferences dialog, 
otherwise they’ll be in the directory where CalSupport PRO was installed, which, unless you 
altered the installer default, is C:\Program Files\CalSupportPRO.

Screen 1 and the Expert Entry screen both display the Case Name and Description fields.

       

    Name of file (variation)  Name of client’s directory  

Naming cases
It will be easier to locate client files if you put last name, first name in the Case Name field. For 
the Description field, use key words that will help you identify the variation.

Notes
You can keep additional notes and comments to help you remember details about the case or 
variation you are working on. Click the “Notes” button to open the Notes popup.

Import/export cases
If your client has the consumer version of CalSupport, you can share the data files. You can, for 
example, send the client a copy of his/her file by email or on a floppy so he/she can work with it. 
Conversely, the client can send you a file for you to work on. Simply put it in the client’s directory 
and double click on it or open the file from CalSupport PRO using the File > Open menu.

the Expert Entry screen
Once you are completely familiar with the basic screens (1–10), you will soon want to run most 
of your cases from the Expert Entry screen. It is more convenient and it displays many analytic 
figures that update instantly with every entry or alteration. See illustration on next page.

Monitor resolution
The Expert Entry screen requires a monitor resolution of at least 1024 x 768 to display fully. You 
can display it at a lower resolution using scroll bars, but this is not nearly so convenient as being 
able to view the entire Expert Entry screen at once.  

To change resolution, use the Display Control Panel (Start > Settings > Control Panels > Display). 
The Display Control Panel can also be accessed on most Windows systems by right-clicking on 
the desktop and selecting Properties from the contextual menu. Once you get the Display Control 
Panel, click the Settings tab and adjust the screen resolution slider bar to set the desired monitor 
resolution. Caution: we have heard that some old monitors can be damaged if you try to set them 
to a resolution higher than they were intended to handle. Consult your manual.
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Current tax year and calculation options are shown in the green header bar.  
Use the return button to toggle back to the basic CalSupport screens.  
The action of this button is controlled in File > Preferences.

Enter data directly into white fields. Click on a grey field to go to the relevant CalSupport screen for entering 
other information. Thus, every CalSupport field can be accessed from this screen.

Results. Guideline and Family Support results are shown in the pink area at the upper-right. 

Analytic figures are displayed in the blue areas. Percentage differences are shown in the column along 
the right of the screen. If (NM) is displayed, it means that the percentage is not meaningful. More about 
these analytic figures in Chapter 6. 

Moving to Expert Entry and back
Mousing.

• From the basic screens (1–10), simply click on the Expert Entry tab to go to that screen.
• From the Expert Entry screen, click on the Return button to go back to the basic screens.

You can control the operation of this button in the Preferences submenu. Go to File > Prefer-
ences > Return From Expert Entry where you can set the action of the button to the screen 
Last Visited (default), Screen 1, or Screen 10.

Keystrokes.  Run the Entry menu with ALT-E then (n), where (n) is the number of the screen 
you want. This is fast and convenient once you get used to it, but other people prefer to click the 
Return button and use their mouse to select screens with the large left-column buttons.

Pick what 2d column shows
Jump to Calc Options Screen
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Online Glossary and Help 
Information that would normally be in a manual is found in CalSupport’s help screens or the 
Glossary and the Help files (two different resources) where it is far more accessible. The Glos-
sary is printed here in the Appendix but, otherwise, this manual does not repeat very much Help 
or Glossary information. What you find in these chapters is additional information and tips that 
clarify or go beyond Glossary and Help screens. For any given item, look first at the help screen, 
then in the Glossary, then in this manual.

How to use Glossary and Help
You can get to the Glossary or Help Topics at any time by selecting from the Help menu. Once 
in the Glossary, you are presented with an alphabetical table of contents which you can browse 
for your topic. If you click the Help tab at the top, you will be transported to the Help Topics 
dialog. From the Help Topic dialog, you view the table of contents by clicking the Contents tab, 
or you can search the Index by clicking the Index tab.
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C H a P t E R    5
ENTERING DATA: ScREENS 1-8 and ExpERT ENTRy

Professional data entry
In the beginning: When you first begin to use CalSupport, be sure to work through all the en-
try screens and carefully study the TIPS items. Make full use of Help Topics, Glossary and the 
manual, too. Continue to use the standard data entry and help screens until you are completely 
familiar with all of the terms and definitions used in CalSupport PRO.

Expert Entry: Once you are completely familiar with all the entries and the help screens have 
become completely unnecessary, you will probably find it more efficient to make all entries in 
the Expert Entry Screen. Of course, if you want to refresh your memory, you can always jump 
from the Expert Entry Screen back to a standard entry screen to view the help screens available 
there.

Client consultation entry: As important as it is for you to understand every term and definition, 
it is equally important that the client understand them, too. Client misunderstanding can lead to 
the reporting of incorrect data and inaccurate results. One way to work with your client is to sit 
with him/her, working through all the standard entry screens and making sure they understand 
the terms and definitions. It’s an educational process and an important one.

Simple cases and quick sketches
There are a lot of fields in CalSupport and you should consider all of them in every case to make 
sure nothing is left out. But, the fact is that many cases can be calculated with only a few lines 
of data entry. Here are the most commonly used entry items:

Screen 1: Enter the case identity information, number of children and timeshare, and the county 
of filing. Timeshare takes thought and discussion so it will evolve over time.
Screen 2: Enter gross wages, self-employment, and other forms of income. Carefully consider 
every kind of income in each case.
Screen 3: Enter the common deductions and child care expenses, if any.
Screen 4: Enter number of children of other relationships living with either party who are not 
being fully supported by child support or welfare.
Screen 6: Enter tax filing status and number of exemptions that will be claimed by the par-
ties.
Screen 7: If child care expenses were entered on screen 3, at least that amount should be entered 
as a child care tax credit on screen 7. If the field for Earned Income Tax credit is available for 
entry, enter at least the number of children for which the party has primary care.

With these few fields, you will be able to get a quick sketch of a case. For many cases, these will 
be all the fields you will need to use. However, always check to make sure the other items have 
been considered and eliminated for every case.

Screen 1: Case Information
Items 1–4, Basic case information. Case Name and Description are discussed in Chapter 4. Items 
2 and 3 take full names that will be used on reports and nicknames that will be used as column 
headers to personalize reports. Item 4 identifies who provided the data for the calculation. 

Items 7–9, Court information. This information is printed on the Bench Reports and should be 
entered before you print a Bench Report for presentation to a court.
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Parenting arrangements
Item 5 – Number of children. Enter the number of children of the relationship who live primarily 
with one party or the other. Read the TIPS window carefully. You can make this entry here or in 
the Timeshare Worksheet (Fig. 5-2), which is better because of the increased detail.

Item 6 – Timeshare. On screen 1 you face the one item that takes the most time and thought to 
define. Because it is based on the parenting schedule, this is something most parents will need to 
discuss and negotiate. It is often convenient to start off using either the “standard” 20% or another 
estimate derived from the Timeshare Chart (described below), then give the client the Timeshare 
Worksheet (under the Reports menu) and suggest the client return to rerun the calculation after 
the parenting schedule has been refined and, ideally, agreed upon. It often helps to run several 
calculations where only the timeshare changes, covering a range of values.

Timeshare is the percentage of time the noncustodial parent has primary care of the child. 
“Noncustodial” means the parent who has the care of the child less than 50% of the time. For 
near 50/50 situations, choose one parent arbitrarily to be “noncustodial” and work out the care 
schedule for that parent. Timeshare is a summary of the annual parenting schedule; so, to be ac-
curate, you need to work one out. This takes time, discussion and agreement, so you might begin 
with an estimate and go for accuracy later. The client should review Chapter 2 before parenting 
is discussed with the other party.

Timeshare Chart. From screen 1, click the [ Time Chart ] button to view a detailed timeshare 
schedule used by Santa Clara county. Some other counties have their own schedules that might 
be a bit different, but in any case these are just estimates and are based on assumptions that might 
not fit a particular case. The parents have to figure this one their own way.

Estimated vs. exact timeshare—agreement is the goal. The parties must either estimate timeshare 
or sit down and work out a likely parenting arrangement in detail. Estimates are easier;  detail is 
usually better. Either way, you eventually need agreement with the other parent that the figure is 
reasonable. Agreeing on the data is the foundation for agreeing on the amount of support. 

Advantages of detail. No matter what terms are used to define custody, what really counts is 
the parenting schedule—when, exactly, will each parent take care of the children? In general, 
the more specific you can be, the better. While parents can always depart from the schedule by 
mutual consent, a reasonably detailed schedule makes it clear later who is supposed to have the 
kids at any given time. A regular, reliable schedule provides stability for the children and the 
parents. A good parenting plan is the basis for a good parenting relationship.

Less detail. Parents may want less detail if they are very comfortable and trusting with each other 
and prefer to leave things as open as possible. Still, it would be good (and some judges insist on) a 
plan that describes the basic features of the parenting arrangement. In difficult cases, you may be 
forced to use less detail if the parties can’t work on the parenting details without causing a major 
blowup. In such cases, it might be better to have a vague agreement rather than no agreement at 
all; just try to agree on one of the standard schedules (Figure 5-1 above) and leave the details to 
be worked out later, and work toward a better relationship in the future.

Fig. 5-1: “Standard” timeshare estimates

These rough estimates have been used in some counties but depend heavily on what parents mean by “weekend”
“Reasonable” or “standard” visitation .............................................................................. 20%
Every other weekend and one month in summer ............................................................ 25%
Three days per week and one month in summer ............................................................ 40%

One weekend per month ........................................................................................ 10% 
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Fig. 5-2: The Timeshare Worksheet

How to use the KidCaretM Scheduler
KidCareTM is wonderful at helping to define the parenting arrangement. It helps to organize the 
parents’ thinking and focuses attention on how they will share the care of their children in very 
concrete terms and it calculates timeshare accurately based on the schedule entered. 

More practical, realistic, committed. KidCareTM helps parents get realistic and practical about 
their parenting and more committed to agreed schedules. Let’s say Dad insists he wants his baby 
40% of the time: that’s good, but what does this really mean in day-to-day terms? Let Dad work 
with KidCareTM to come up with a proposal for exactly what schedule he has in mind. Dad may find 
out for himself that 40% runs completely afoul of his work and social schedule. If he still wants 
40%, that’s wonderful; he’ll be more committed to it, having worked it all out for himself. 

How to use KidCare. KidCareTM is available from the Timeshare Worksheet (above) after one 
or more children have been entered. You open a KidCareTM schedule for each child by clicking 
on the blue [ KidCare ] button at the right of each child’s name. 

• Define the annual care schedule for the noncustodial parent. “Noncustodial” means the parent 
who has care of the child less than 50% of the time. For 50/50 situations, choose one parent 
arbitrarily and work out the schedule for that parent. 

• Enter the care schedule for the selected child. The result will be entered in the Timeshare 
Worksheet. If the schedule for another child is identical, simply copy the same timeshare figure 
for the other child and enter that figure directly in the Parenting popup. If other children have 
different schedules, run a KidCareTM calculation for each different schedule and enter the results 
accordingly.

Use pick list to enter 
birth month and year

Click to toggle 
primary caretaker

Enter 
child’s
name

Result of all entries summarized here Click to display timeshare chart

This is the best place to enter information about the children as it collects details that are useful in CalSupport re-
ports and calculations. By entering the birthdays, CalSupport can apportion support between specific children. This 
worksheet is especially important where you have split custody or different care schedules for different children. 

Support  for
each child. 
Not accurate 
until other 
screens are 
completed. 
Use it  to 
see how a 
change in 
timeshare 
affects child 
support. 

Link kids with 
the same schedule

Enter timeshare, or click KidCare 
to create schedule for that child

To create an entry for
another child, click here 
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How to enter a schedule in KidCareTM

KidCareTM, like most courts, counts nights. All choices are reflected in the calendar.

1- Weekend Nights. Define your plan for a typical weekend. From the first pick list, define 
whether the schedule will take place every weekend, alternate weekends, or something else. 
In the next pick list, choose which weekend nights will be involved. Obviously, not every 
weekend will be identical, but enter what you plan as the average weekend.

2- Weekday Nights. Define your plan for a typical or average midweek by checking a box 
to show which nights will be involved. In the next pick list, define whether the schedule will 
take place every week, alternate weeks, or something else. 

3 - Major Holiday Nights. For Spring Break and Winter Break, click the [ Define ] button 
for a popup where you indicate how many days and when the time starts to run. Thanksgiving 
is only a four-day weekend, so you either check it or not. If you need to refine any of these 
periods further, simply click on the calendar to add or subtract nights.

4 - Other Holiday Nights. Simply click on the calendar to add days. There are long weekends 
like Memorial Day, 4th of July, and Labor Day, then there’s President’s Day, Columbus Day, 
Martin Luther King Day, Passover, Ramadan, Kwanza, and so on. These will vary from family 
to family and school to school. Consult the calendar for your child’s school. 

5 - Summer Vacation. Click the [ Define ] button for a popup where you define the number 
of weeks and when the time starts. If you need to refine any of these periods further, simply 

Fig. 5-3: The KidCareTM Scheduler
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click on the calendar to add or subtract nights. Also do this to account for any time the other 
parent might have the child back for visits.

6 - Miscellaneous Weekly Hours. If there is regular care that does not amount to a full night, 
like, say, four hours every Wednesday, you can deal with that here.

7 - Days clicked on the calendar. These two figures show the accumulated number of days 
that you added (the first figure) / or subtracted (second figure) by clicking on the calendar. The 
[ Clear ] button will restore to normal all days you changed by clicking on them, in case you 
lose track of what you clicked on and want to start over.

Total care days (nights) is reported at the bottom right of the KidCareTM  screen. 

Timeshare Percentage (based on Total Care Days) is shown in the last field. When you click [ OK 
], the figure will be entered automatically in the Timeshare Worksheet for the selected child.

To Print the KidCareTM schedule. Return to the main screen and select “KidCareTM  Reports” 
under the Reports menu. 

Screen 2: Gross Income 
Actual income vs. earning ability. Generally, you consider the income a party actually earns, 
but there are three exceptions. 

1. Income can include a reasonable amount of regular overtime, but you can’t expect a person 
to work excessive hours or two jobs indefinitely or against their will even if they have been 
doing it on a regular basis. 

2. When a party voluntarily quits work or reduces income and employment at a higher rate is 
available, a judge might calculate support using earning ability rather than actual income. On 
the other hand, it costs a lot to get in front of that judge, so try for a reasonable compromise. 
If this is a problem the client should get advice.

3. If you don’t have any information about the party’s income or work history and have no 
reasonable way to find out, but you believe him/her to be in good health and employable, enter 
California or Federal minimum hourly wage in the Wage popup (below).

Wage calculator popup (see Figure 5-4)
At Screen 2, item 1, the popup button brings up a calculator that lets you enter wage income in 
any of seven different pay periods, including year-to-date, without having to reset the time basis 
of the whole case. Very convenient.

Overtime and bonus income. In addition to base wages, the calculator also provides fields to  
let you calculate and add regular overtime and bonus income. 

Military pay. Item 7 has an informational popup that explains the intricacies of adding military pay 
into a support calculation—that is, which of numerous items are taxable and which are not. 

All other information for Screen 2 can be found in the TIPS window and the Glossary.

Screen 3: Authorized Deductions
Authorized items are sometimes (confusingly) called “mandatory deductions” by lawyers and 
judges, lumped together with authorized shared costs (add-ons) discussed below. We use the term 
“authorized” in CalSupport to refer clearly to items the law says must be included in support 
calculations to the extent they can be documented (proved). 
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Discretionary items. In contrast, other amounts are discretionary and will be included only if 
the parties agree or a judge hears evidence and orders it. There are two kinds of authorized items: 
deductions (Screen 3) and authorized shared costs (Screen 5, items 1 and 2). 

Special note about health care
Health care entries appear in three places so it is easy to get confused. Here’s what they are 
about:

Health insurance for self and children (Screen 3, item 1) is for amounts paid for health 
insurance for the party and any children the party is obligated to support. Note that this item  
has a [Refine] button inviting you to indicate more specifically how this amount is treated on 
the party’s tax return. This will produce a more accurate tax calculation.

Uninsured health care actually being paid for children of this calculation (Screen 5, item 2). 
Does not include the amount entered above. Amounts actually paid are presumed reasonable. 
Good evidence is required to overcome the presumption. This amount will be shared by the 
parents as additional child support. 

Extraordinary health expenses for which party is responsible (Screen 4, item 2). Does not 
include either of the above. This is for the party and the party’s dependents other than children 
of the calculation. Here again, it is best to include long-term amounts regularly paid.

Fig. 5-4: The Wage Calculator popup
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Regular, long-term expenses only. Because of the long-term nature of child support, it is best to 
include only amounts that will be paid regularly over the term of the child’s minority. Short-term 
amounts should be negotiated separately. 

All other information for this screen can be found in the TIPS window and Glossary.

Screen 4: Discretionary Deductions
Discretionary deductions are amounts that the law says may be included in support calculations 
if the amounts paid are documented and if the parties agree to do it or a judge hears evidence 
and orders it. In contrast, other items are authorized and must be included if they can be proved. 
There are two categories of discretionary items: deductions (Screen 4) and shared costs, also 
referred to as “additional child support” (Screen 5).

Item 1, Necessary job related expenses. The parties can agree to include this one, but before 
allowing it a judge would have to hear evidence that the amount was necessary, required for 
employment and not compensated by the employer: such things as tools, clothing, travel, etc.

Items 2 and 3, Extraordinary health costs and catastrophic losses, are referred to as “hardship” 
deductions. They are rarely seen in practice. See the Glossary if you plan to use them.

Item 4, Children of other relationships who live with the party, also referred to as a “hardship 
deduction.” This deduction is for cases where the parent has a live-in minor child by another party 
who is not adequately supported by the chhild’s other parent or by welfare. A judge would almost 
certainly allow this deduction unless there is some reason why it would not be fair to do so. 

At item 4, enter ther number of children from other relationships who live with the party, then 
click the [Enter] button to get the popup and refine how CalSupport calculates this deduction. 

The popup for live-in children of other relationships

Items 2–3, choose one: maximum allowed or calculate from actual expenses. If neither is 
selected, there will be no hardship deduction. 

Item 2. For convenience, you can choose to enter the highest deduction permitted under 
the facts you have entered, or 

Item 3. Do it the way that is technically correct: enter the amount actually spent for “mini-
mum basic living expenses” of the live-in children and enter the amount of child support 
or welfare received for them. 

We recommend that you choose to use the maximum allowed deduction except in cases 
where some child support or welfare is received for the child.

Item 4, income allocation. There are two ways this deduction can be calculated: the legal way 
or the fair way. The fair way—income allocation—can only be used if the parties agree to use it. 
Check this box if the parties agree to use income allocation.

Support paid is the method provided by law. The deduction allowed is limited to the average child 
support actually paid: the total amount the high-earner pays divided by the number of children for 
whom it is paid. In some cases this can produce results that are clearly unfair. If support actually 
paid is very low because the paying parent has a high degree of care (timeshare) or because the 
recipient has a high income, then the maximum amount permitted will be unreasonably low for 
reasons unrelated to the circumstances of the parent or the live-in child. Either the high or the 
low earner can be unfairly affected under this method, depending on circumstances.

Income allocation allows a live-in child to the same allocation of income as the children who 
are subject to the support calculation. All children of the party are being treated equally. This 
method is not approved by the Judicial Council and cannot be used unless the parties understand 
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the matter and agree that it is more fair to use it. You would not use it, for example, if the live-in 
child is amply supported by child support that is actually received.

Screen 5: Shared Costs
These are child care costs that will be shared by the parents.

Items 1–2.  Items 1 and 2 are authorized and must be included if the expenses can be proved.

Items 3 and 4. These are discretionary and will be included only if the parents agree or a judge 
decides to include them. 

Item 5, How shared. Under the law, child support add-ons (often called “additional child sup-
port”) are to be shared equally (50/50) unless the parties agree or, upon request of either parent 
with supporting documentation, a judge determines that it is more appropriate and orders that 
add-ons be prorated according to the “adjusted net incomes” of the parties as defined in Family 
Code § 4061. The exact proportional share is displayed and it changes fluidly according to entries 
made on other CalSupport screens.

If the parties have significantly different incomes, a judge would normally order prorated sharing 
of additional child support unless there were some good reason not to do so; for example, if the 
judge feels the support burden on the payor is already high enough. In practice, this is just one 
of the items to be negotiated by the parties. Run CalSupport both ways and see what difference 
it makes either way so the parties can see what is at stake.

Screen 6: tax information
Item 1, Tax filing status. This choice will make a big impact on the result. Read the TIPS window 
and the Glossary, then consider carefully what it will be.

New spouse information. If either party is filing MFJ New Spouse (Married Filing Jointly with 
a spouse who is not party to the calculation), click the [New Spouse] button and enter income 
and other information for the new spouse, to be used only for the tax calculation. 

Item 2, Total exemptions claimed. This item will have a big impact on the result. All entries 
are made in popups that you reach by clicking on the [Change] buttons.

Item 2a, Number of children of this relationship. This number is collected from Screen 1. 
It is often possible for the family to come out with more spendable income if the low-earning 
custodial parent releases exemptions to the high earner. To enter a release, click the [Change] 
button and enter the number of exemptions that are going to be released. 

Note on released exemptions. 
a) Each year, the parent releasing exemptions must sign IRS form 8332 and not claim the 
released kids on his/her tax return. This requires continuing cooperation and good will.
b) If the low-earner is in the eligible range, giving up the exemption for a child means the 
parent cannot use that child for the Child Tax Credit (Screen 7, item 5). Be sure to run the 
calculation both ways—with and without released exemptions—and see which way the 
family comes out with the most net income.

Automatic calculation of optimum releases. CalSupport calculates the number of exemption 
releases that will provide the most tax savings and combined spendable income for the par-
ties. This number is reported on Screen 6, at item 2, and on the Expert Entry screen, bottom 
center.

Item 2b, Number of other exemptions claimed. If there are other dependents that can be 
claimed, click the [Change] button and enter them in the popup. If the party’s tax filing status 
is “MFJ New Party,” be sure the new spouse is claimed as an exemption. 
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Item 3, Amounts contributed to Flex plan. Enter any amount contributed by either party to a 
Flex plan provided by an employer. Any deductions taken over the Flex amount entered here will 
be calculated as ordinary Schedule A deductions. Click the [Refine] button and indicate more 
specifically how various potential flex expenses are treated on the party’s tax return. 

Item 4, Is party a resident of California? 

• If you answer Yes, the amount of California income tax and State Disability Insurance will 
be calculated automatically.

• If you answer No, then at item 4 you must enter the amount paid in some other state for 
income tax and state disability insurance or the equivalent. You might find it more convenient 
to change the Time mode to Annually when making this particular entry.

• In the rare case where the party happens to pay state taxes in California and some other state, 
enter No here and at item 4 enter the amount paid annually in both states for income tax and 
state disability insurance or the equivalent. You might find it more convenient to change the 
Time mode to Annually when making this particular entry.

Item 5, Exemption from deductions for FICA or SDI. 

• “No” is the normal answer and the deductions will be automatically calculated and deducted 
by CalSupport. Most people are not exempt—if you look at their paycheck stubs you will find 
deductions for FICA (Social Security and Medicare are bundled together and called FICA). 
SDI is a state deduction and is usually noted separately on paycheck stubs. 

• Some employees of public agencies or religious associations are exempt from one or all of 
these wage deductions. Examine paycheck stubs to see. If the employee is exempt from paying 
any of these items, click the Popup button and enter details in the Exemptions popup. Sometimes 
when an employee is exempt from these deductions, you will find that similar deductions are 
taken from their wages for retirement and health insurance, in which case these amounts will 
be entered on Screen 3 as union dues, retirement or health care.

All other information for this screen can be found in the TIPS window and Glossary.

Screen 7: Tax deductions
Item 1, Tax deduction method. When filing a tax return, a taxpayer can either itemize all de-
ductible expenses or take a “standard” deduction. The amount of the standard deduction is fixed 
by regulation from year to year. When using CalSupport, you can choose the standard deduction, 
itemize deductions, or estimate the amount of taxes. These work as follows:

a) Standard deduction. If you choose this method, CalSupport automatically applies the cor-
rect standard deduction. Many attorneys believe the fairest way to figure support is to use the 
standard deduction method for both spouses. This is because a person who has high expenses 
pays lower taxes and thus has more left over to pay toward support. They think it is unfair that 
higher expenses should result in higher support. For example, why should tithing your church 
or straining to put more away for retirement, or paying into a high mortgage mean that you 
pay more support? On the other hand, the recipient would probably rather force an accurate 
calculation of tax savings in order to get more support. By the way, the converse is also true—
a recipient who pays less taxes will get less support. The deduction method is a subject for 
negotiation. Absent agreement, you have to use the actual method used on returns.

b) Itemized deductions. For people who have high deductible expenses, especially home 
mortgages and property taxes, itemizing expenses (carefully and completely) can produce 
lower taxes and therefore somewhat higher support. The results may be more accurate in such 
cases than using the standard deduction. To enter itemized deductions, click on the Itemize 
button to get the itemization popup.
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Report or the Net Income Report; federal taxes will be in parentheses if EIC is paid, indicating 
a positive number, a payment.

Item 9, California tax credits. Use this popup to claim the California Renter’s Credit or Joint 
Custody Head of Household Credit or any other California tax credit. Be sure the client is told 
to actually apply for whatever is claimed here. Read the Glossary and the popup help menus 
carefully.

Screen 8: Special circumstances
These items are not commonly used in practice, but they should still be considered in every 
case before they are eliminated. All other information for this screen can be found in the TIPS 
window and Glossary.

the Expert Entry Screen

the Expert Entry Screen
Once you are completely familiar with the basic screens (1–10), you will soon want to run most 
of your cases from the Expert Entry screen. It is more convenient and it displays many analytic 
figures that update instantly with every entry or alteration. 

The Expert Entry Screen
is discussed on the next page Æ
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Current tax year and calculation options are shown in the green header bar.  
Use the return button to jump to the basic CalSupport screens.  
The action of of this button is controlled in File > Preferences.

Enter data directly into white fields. Click on a grey field to go to the relevant CalSupport screen for enter-
ing other information then, when done, return to this screen by clicking the Expert Entry button in the left 
column.

Results. Guideline and slected comparison results are shown in the pink area at the upper-right. 

Analytic figures are displayed in the blue areas. Percentage differences are shown in the column along 
the right of the screen. If (NM) is displayed, it means that the percentage is not meaningful. Read more 
about the analytic figures in Chapter 6—Getting Results. 

How to use it
The Expert Entry screen gives you access to every field in the basic CalSupport Screens 1–10. The 
white fields are duplicates of the most frequently used entries in the basic screens. Clicking on a 
grey field will bring up a basic screen or popup to give you access to other entry fields. For every 
case, go down the entry columns and consider every entry. Click on each grey field to view the 
basic screens. Use them as a check list to make sure you’ve thought of and covered everything.

Pick what 2d results column shows
Jump to Calc Options Screen
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C H a P t E R     6
gEtting rEsults

Calculation options: Screen 9
The calculated results are displayed in two columns on Screen 10 and Expert Entry: first the 
Guideline figures, then a variety of comparisons in the second column. Screen 9 controls options 
that affect the results displayed in those two columns.

Guideline support options (items 1 and 2(a-c))
These options affect the results displayed under the Guideline column on Screen 10 and the 
Expert Entry screen.

1. Low income adjustment. If payor’s net income falls below $1,000 per month, CalSupport 
will report a range for adjusting Guideline support that the law presumes will be applied unless 
there is evidence presented to show that it would be unjust to use it. Judge’s discretion. 

2a. Spousal support formula. Select the county where the case is (or is likely to be) filed. Judges 
are not bound by any formula for the award of spousal support; in fact, they are required by law 
to exercise discretion on a case-by-case basis. However, as a practical matter, in typical cases, 

Fig. 6-1    Screen 9: Calculation Options
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awards tend to fall near the guideline figure, so it does provide a rough guide that will help par-
ties negotiate. They must weigh the possibility that they might win enough to outweigh the huge 
cost of going to court rather than negotiating a compromise.

All but a few counties in California have indicated a preference for a formula to guide judges 
in the award of temporary spousal support. The Santa Clara formula is used in 37 counties and 
8 counties use the Alameda formula. No other formula is used by more than three counties. The 
primary difference between the two is that the Santa Clara formula is the same whether or not 
there is child support in the case, while Alameda applies a slight reduction where there is child 
support.

2b. Set spousal support formula. For counties (or judges) that use a different formula from the 
one in CalSupport, or where (as rarely happens) parties agree to use a different formula. See the 
next section below for a discussion of how the formulas work.

2c. No spousal support. Check this if you do not want CalSupport to calculate spousal support. 
Maybe the parties have never been married; maybe they have agreed not to have it.

No child support. This is not a calculation option. If the parties have no children or for some 
other valid reason do not want to calculate child support, make sure “0” is entered for both par-
ties for the number of minor children (Screen 1, item 5).

Comparison column options (items 3–5)
3a. Fixed child support.  Allows you to set who pays and exactly how much. This lets you see 
what will happen to net income and other financial analysis if the parties agree to some amount 
other than the recommended guideline amount.

3b. Fixed spousal support.  Allows you to set who pays and exactly how much. This lets you 
see what will happen to net income and other financial analysis if the parties agree to some 
amount.

Family Support options 
Family Support applies optimum release of exemptions and minimizes taxes by shifting nonde-
ductible support child support to deductible spousal support. This requires careful tax planning 
and careful drafting of the MSA, otherwise it won’t get by the IRS. Consider this an indication 
of how much it would be worth to an agreeable couple to get good legal and tax assistance.

4. Set net spendable income (NSI). If one party must have a minimum amount of spendable 
income, this calculates the amount of support that will produce that result. CalSupport figures  
NSI in two different ways that can be selected in the second-column picklist on Screen 10 or the 
Expert Entry Screen:

a. Family Support = User-set NSI. This figures the amount of Family Support that will pro-
duce the desired amount of nets spendable income. 

b. Guideline + Adj. SS = User-set NSI. This applies guideline child support and then adjusts 
spousal support in order to produce the desired net spendable income.

5. Set total Family Support. Displays results and financial analysis for Family Support which 
has been fixed to an agreed total amount.
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Understanding spousal support formulas
The Santa Clara formula is as follows: 

   SS =   (.4 * HN) - (.5 * LN).  
   SS = Spousal support
   HN = High earner’s net disposable income
   LN = Low earner’s net disposable income

 Net disposable income is defined in the child support guidelines, Family Code § 
4059.

– In English, this means that spousal support will be 40% of the high earner’s net disposable 
income minus 50% of the low earner’s net disposable income. 
– If there are children, the amount allocated to each party for child support is deducted from 
their net incomes, but the same factors (40% of HN minus 50% of LN) are applied. Note that 
“amount allocated” is not the same as guideline support. See the Bench Report for amounts 
allocated to child support.
– Net disposable income is adjusted for the tax effect of paying and receiving spousal sup-
port. This means that the amount saved by the high earner due to deducting spousal support 
paid will be added to net income, and the amount of tax paid by the low earner due to spousal 
support received will be deducted from net income, then the calculation will be run again and 
yet again until the change due to considering tax is insignificant. In short, the parties share the 
gains and losses due to the tax effect of paying spousal support.

The Alameda formula is exactly the same as the Santa Clara formula if there is no child sup-
port in the case. If child support is being paid, the 40/50 factors are changed to 35% and 40% 
respectively. This means that after the amounts allocated to the parties for child support are de-
ducted from their net disposable incomes, spousal support will be 35% of the high earner’s net 
disposable income minus 40% of the low-earner’s net disposable income. The effect is a very 
slight reduction in spousal support when child support is being paid.

The Marin formula is the same as the Alameda formula except that in cases where child support 
is being paid, the factors are 35% and 45% respectively. This a very slight difference.

In San Diego, the formula recommended by the Bar is the same as the Alameda formula except 
that in cases where child support is being paid, the factors are 35% and 50% respectively. 

The spousal support options section offers a popup list of all California counties with the formula 
recommended for use with each county. You can also directly select the formula you want to use 
from the list of available formulas. Once you choose a formula, CalSupport will automatically 
make any adjustments required by the selected formula if there are children in the case.
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The Results: Screen 10
Screen 10 displays the calculated results based on all data entered and calculation options selected 
on Screen 9. 

Items 1–4, Calculated results in two columns
Results are displayed in two columns. 

Guideline. The first column always shows Guideline support as affected by the number of exemp-
tion releases actually entered by the user, if any, which is reported just below item 4. 

Comparisons to guideline. The second column allows you to choose what you want to compare 
to the guideline figures. Here are the choices and how they are defined:

Family Support: Maximizes tax savings with optimum release of exemptions and optimum 
conversion of nondeductible to deductible support (child support to spousal support).

Fixed Payments: Displays the results when the user sets a fixed value for child or spousal 
support or both on Screen 9, item 3a or 3b.

2d column pick-list. Choose what you want to compare to guideline support. 

Tax year currently in use

Fig. 6-2    Screen 10: The Results 

Time period selected under Time menu  
and currently displayed in all fields.
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Family Support = User-set NSI: When one party simply must have a minimum amount of 
net spendable income, set it on Screen 9, item 4. A variation on Family Support, this also 
seeks to maximize tax savings by releasing exemptions and shifting nondeductible to deduct-
ible support.

User-set total Family Support: Shows the affect on taxes and other analytic figures when 
parties want to consider agreeing to a total amount of Family Support. 

Guideline Optimum or w/ no releases: Shows guideline support with optimum release of 
exemptions or, alternatively, no releases. These can be used to illustrate the value (effect on 
guideline) of this one bit of cooperation. If parties can do this to save on taxes, perhaps they 
will contemplate other forms of cooperation.  

Guideline + Adj. SS = User-set NSI. This is an alternative way to get to an amount of net 
spendable income set on Screen 9, item 4. This variation applies guideline child support then 
adjusts spousal support to produce the desired NSI.

N/A. If you pick a comparison for which no corresponding entry has been made on Screen 
9, CalSupport PRO will display N/A to tell you this choice is not applicable. 

Item 1 shows total support and who pays whom.

Item 2 shows the amount for child support, the calculation option selected on Screen 9 (usually 
this will say CA Guideline). If the Low Income Adjustment applies, it will say so here; it means 
that the payor has net disposable income of less than $1,000 per month and the amount will dis-
play a range within which support can be adjusted by the parties or a judge. If there is an amount 
showing on this line under the comparison column, it means that there was no tax advantage 
to converting the entire child support amount to Family Support. Child support amounts are not 
tax deductible to the payor nor taxable to the recipient.

Item 3 shows Spousal Support (column 1) or Family Support  (column 2). These amounts are 
tax deductible by the payor and taxable to the recipient.

Item 4 shows the amount of child support add-ons and the manner in which they are apportioned 
between the parties, either 50/50 or prorated according to adjusted net incomes.

Released exemptions actually entered by the user are displayed in the line after item 4. This 
figure is taken from the popup for Screen 6, item 2.

Bottom line. If the parties can agree to the data entered and calculation options selected, then 
this result is the amount that a judge would order for child support and a fairly good indication 
of what a judge might award for spousal support. Let the negotiations begin.

Note: The success of family support is based on actual tax savings so it deserves accurate tax 
accounting that is beyond the ability of any support program. Take the family support result as 
an approximation that helps the client decide whether to inquire further. A client who plans to 
use family support should consult a tax accountant for a real tax workup of the case.

Items 5–6, Net Disposable Income. This shows the Net Disposable Income which is the result 
of all data entries. Net Disposable Income is defined by Family Code 4059 and 4060 and is the 
numeric basis for calculating Guideline Child Support.

Items 7–8 show the net incomes for the parties after support is paid. The percentage figures to 
the side will help you see the relative advantage of Family Support for each case variation.
Note. A more detailed analysis of income and net income can be found on the Net Income Re-
port.
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Results: The analytic figures on the Expert Entry screen
Results displayed in the pink area are discussed in the previous section (Screen 10) as are the net 
income figures at the lower left. Below the results are some useful analytic figures described in 
Fig. 6-3. At the right of each figure, you can see at a glance the change between Guideline Sup-
port and whatever comparison is being shown in the comparison column. If (NM) is displayed, 
it means that the percentage comparison is not meaningful.

Net Disposable Income for both 
parents; compares change in 
family income.

Compares change in total taxes 
and net spendable income be-
tween Guideline support and the 
second column comparison.

Net paycheck is gross income 
of any kind less taxes.

Shows how many withholding 
allowances an employed party 
should claim on the W-4 form.

Difference in NSI with the  
exemptions taken as indicated 
vs. claiming none.

% change for each item is 
shown in the far right column. Results. Same as Screen 10.

Actual cost or value of support to 
the party after taxes applied.

Results. Same as Screen 10.

2d column pick-list. Choose 
what you want to compare to 
guideline support.

Releases actually entered by user
Optimum releases to produce max NSI

Fig. 6-3   Expert Entry Screen Analytic Figures

Releases used to produce results shown
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Comparing results with other programs
Sometimes one of the parties gets a computer printout from DissoMaster™, SupporTax™ or some 
other program—maybe even CalSupport—with a different result. Of course, they both want to 
know what happened. It’s a reasonable question.

Summary of differences with DissoMaster. 
1. Entries. The most common source of difference is in the entries, so first compare these 
very carefully to be certain the same data has been entered. 
2. Tactics. Next, look at DissoMaster’s hidden settings to be sure the user wasn’t fixing the 
results (tactics 1–7). Tactics 8b and 8f are most like CalSupport. 
3. Tax credits. By default, DissoMaster applies all tax credits, even the Renter’s Tax Credit 
when the party owns a home. You have to dig deep into the settings to change the selected 
tax credits, but if different tax credits are being applied, this can result in significantly dif-
ferent tax burdens that will impact the amount of guideline support. 
4. Released exemptions. DissoMaster might appear to be releasing exemptions when in 
fact they are taken only for Family Support or only in federal but not state taxes. This error 
is easily found in the tax reports. 
5. Compare tax reports. Differences almost always come from different tax calculations, 
so it is very useful to compare tax reports. CalSupport provides tax reports that break out 
taxes fairly completely. However, you have to block spousal support from DissoMaster’s 
calculations first, before you can see guideline child support tax figures, otherwise you’ll 
only be able to see tax figures with spousal support mixed in—another superior feature of 
CalSupport. Once you block the spousal support, you will be able to compare DissoMaster’s 
tax figures with CalSupport’s Child Support Tax Report. Compare tax figures with those of 
any other program and you should be able to identify the cause of any differences. 

1. Check the data: This is the most common cause of differences, either because different data 
was used or the same data was entered differently. You have to compare the data that was input 
into each program very, very carefully. 

CalSupport™ has many more entry fields than other programs and each field is specifically 
defined. In other programs, it might take a trained professional to determine what data goes 
into which field, and several items of data might be combined and entered into one field. 
DissoMaster™: Get page 1 of the “Formal Printout” plus the “Input Screen.” Compare these 
with CalSupport’s Support Summary Report. Also ask for the “Settings” printout.
SupporTax™: Get the All-Input Report, which shows every data item and all options. Compare 
with CalSupport’s Support Summary Report. 

2. Check the settings: If different calculation options were used, or if the calculation was based 
on a different tax year, you can expect different results. Make sure both programs were current 
and used tax tables for the same year.

DissoMaster™ has many technical options reported on two screens.
• On the main input screen printout, check the date of the report, the tax year and the Tactic. 
Tactics 8b and 8f are most like CalSupport. Tactic 8b allows two-way payments. CalSupport 
allows two-way payments only if guideline support specifies two-way payments (when child 
support is owed to one party and spousal support is owed to the other). Be suspicious of “Pro-
posed” support—tactics 1–7 mean the user is fixing the results. Ask the other party to go back 
and get a report based on tactic 8f and negotiate away any differences. 
• You want to see the first page of the “Settings” printout. Pay special attention to the State and 
Federal tax credits to see if any were included in one program but not the other. For example, 
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DissoMaster blocks the California Renter’s Credit only if the party is paying property tax, and 
this is not always the correct choice. 

SupporTax™ reports the tax year and calculation options in the All-Input Report. SupporTax 
refers to family support as “optimized” support.

3. If the data and options check out: If all data checks out, the same options were used in both 
cases, and the same tax year was calculated, then there should be very little difference between 
results produced for child support. In some cases, DissoMaster can produce small differences, 
especially in higher income ranges, due to technical differences in the way the programs treat 
taxes. Small differences can be negotiated. Large differences are probably due to entry error or 
different options having been used in DissoMaster or differences in the inclusion or exclusion of 
tax credits. DissoMaster 2002 can make errors in released exemptions (see summary above).

DissoMaster’s differences. There are three things that DissoMaster does differently from Cal-
Support and SupporTax that can sometimes account for different results:

1) DissoMaster allows authorized deductions to be greater than a party’s net disposable income 
(NDI), but we believe that is a misinterpretation of the intent of the statute so do not allow 
deductions greater than NDI.
2) DissoMaster applies certain tax credits automatically and requires an override if you don’t 
claim one or another of them. Sometimes this can introduce an error.
3) DissoMaster allows a hardship deduction for live-in children of other parties, even when 
the parties themselves have no minor children. CalSupport limits the hardship deduction to 
child support actually paid; if none is paid, there is no deduction.

DissoMaster spousal support error. In some situations, DissoMaster can produce a noticeable 
difference in spousal support which also shows up in the Family Support result. We believe Dis-
soMaster contains an error in the way they distribute tax savings from the payor’s deduction of 
spousal support payments. DissoMaster allows the recipient’s share, bottom line, to fall below 
the amount specified in the formulas. 

DissoMaster is popular among many judges and lawyers, so you can’t simply disregard it. This 
simply means you are left with one more item on your list of things to negotiate. Compromise; 
this isn’t worth fighting over.

Get advice
If you find all this confusing, you aren’t alone. Many judges and attorneys find it difficult to track 
down and understand these differences. If you want some expert advice and ideas about how to 
handle your situation, talk to a family law attorney, or call Divorce Helpline. For a reasonable 
charge, our attorneys will help you understand your case and look for practical solutions that 
will lead you to a fair settlement.



Chapter 7: Understanding and using CalSupport reports

59

C H a P t E R     7
undErstanding and using calsupport rEports
Viewing and printing reports

The Reports menu. Under the Reports menu, there are two ways to print or view any report or 
group of reports.

• Select a report. Selecting a report under the Reports menu will either save that report as a 
PDF file or bring up a preview on your monitor which you can view and then print. The action 
taken depends on your setting in the File > Preferences dialog (see below).
• Report Selector. Using the Report Selector, you can select one or several reports and either 
print them, create them as PDF files, or preview them first and then print. 

Print Setup. Available under the File menu or as a button on the Reports Selector, this brings 
up the Windows dialog where you can choose and control the printer you want to use to print 
reports.

Time period. Reports will be printed in whatever time period the CalSupport screens are set in 

Select all reports Clear all selected reports

Preview on monitor

Fig. 7-1: The Report Selector

Print selected reportsCreate PDF file
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when the report is printed. In other words, if you want monthly values on the report, make sure 
CalSupport is set for Monthly values when you print. Time is set using the Time menu.

Rounding off. All numbers are maintained internally to several decimal places but when they 
are displayed on screen or in reports, they are shown as whole numbers. This is why sums may 
occasionally appear to be off by ± 1. 

Before you print, check to make sure the date is correctly set on your computer. Make sure your 
printer is turned on and ready.

Print reports or save as PDF
CalSupport PRO will print reports or save them as PDF files. PDF files can be viewed with the 
free Acrobat Reader. If you or your client don’t have it installed, go to www.adobe.com and 
click on the [Get Adobe Reader] button to get the latest version for your particular operating 
system. The advantage of PDF files is that they can be viewed on any computer, look the same 
on any computer, and you can easily email reports to clients or open several at a time on your 
computer for cross-comparison. 

The Preferences dialog (File > Preferences) controls what happens when you select a single 
report under the Reports menu. You can select or deselect “Prefer PDF for Print Preview.” It is 
selected by default.  

1. PDF selected. If “Prefer PDF” is selected (PRO’s default), whenever you select a report 
under the Reports menu, the report will be saved in your client’s folder as a PDF file.
2. PDF deselected. If you deselect “Prefer PDF,” selecting a report under the Reports menu 
will bring up a preview on your monitor which you can view and then choose to print. 

PDF file names. You can always choose whatever name you like for any report, but if left to 
itself, PRO will save a single report under the name of the report plus the date saved:  (BenchRe-
portJan11,2004.pdf). More than one report will all be saved as “Combined” plus the date (Com-
binedJan11,2004.pdf). If Windows is set not to show file extensions, you won’t see the “.pdf” 
extension. We believe that setting Windows to view file extensions is very useful.

Fig. 7-2: The Reports menu

Under the Reports menu, you can choose the Reports Selector (Figure 
7-1) or any one report. The File > Preferences menu controls what hap-
pens when you select just one report—either save as PDF or preview 
on your monitor and, if you like, print it.
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the Support Summary
This report has several goals:

1. Show the results—the correct amount of support indicated by the guidelines.
2. Show exactly what data was used to calculate the results.
3. Show the calculation options that were selected to calculate the results.
4. Show the date the report was printed and the date of the CalSupport version. This lets people 
know whether the results are current.
5. Explain what the results mean in practical terms.

The Support Summary helps parties communicate about support issues. Most important, it changes 
the focus of their dialog from arguing about the amount of support to the much easier task of 
discussing the accuracy of income and deduction information that was used to get the result.

It is important to use the Support Summary together with Chapter 2, so make sure your client 
has them both. Ask your client to check all the entries and options and report back to you if 
any need correcting. Tell the client to read Chapter 2 before talking to the other party about the 
results. Eventually, the client should send a copy of the Summary Report to the other party and 
ask them to verify the information that was used. Invite discussion about the figures and how to 
get them to the point where both parties can agree that the figures used are correct. If the figures 
are correct, the parties can negotiate a support agreement somewhere near the results reported 
by CalSupport. 

The Support Summary has two parts. The result and all the variables used to calculate that result 
are on pages 1, 2 and 3. Pages 3 and 4 contain some basic information about child and spousal 
support. It is very important that both parties have the entire report—the report clearly lets them 
know that there are four pages in all. 

Bench Reports
CalSupport produces three versions of the Bench Report for use in court, any of which can be 
used in court if ever the parties go in for a hearing on a motion, OSC or Judgment. Use which-
ever format the judges in your county seem most familiar with. According to California Rules 
of Court 5.275, “All courts must permit parties or attorneys to use any software certified by the 
Judicial Council under this rule.”

In many counties, the Bench Report won’t be needed if the parties have a written agreement, but 
some counties want to see the Bench Report in any case. Either way, there is a lot of information 
in this report that will be of interest to the parties. If there is more than one child and custody is 
not split, child support will be allocated to the children in the line under the Guideline figure.

Input Information
PRO version only. This bench report looks similar to the “Input Screen” printout produced by 
DissoMaster, a program that is used by many judges. It contains entry items and analytic figures 
found on CalSupport’s Expert Entry screen.

Support Order
This report looks very similar to the bench report produced by DissoMaster. Judges are quite 
used to seeing this format and are comfortable with it.
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Findings and Orders
This report looks very similar to the bench report produced by SupporTax, a program that has 
been used in courts since 1984. Judges in some counties are quite used to seeing this format.

Net Income Report
This is a detailed illustration of how each party’s gross income is affected by taxes, deductions, 
support paid and received, and additional child-care expenses. It shows the net amount remaining 
to each party for living and other expenses. 

Additional Income tables
These tables show how support will be affected if either party should receive future income that 
was not already included on Screen 2 in your guideline calculation. They display a range of 
possible income amounts and the resulting change in support. If the parties agree, or if the court 
orders it, these tables can become the basis for adjusted support payments in the future if and when 
new irregular income is earned. Note: this is only for one-time, short-term, or occasional future 
income. If either party gets a new stream of reliable income in the future, you should include it 
on Screen 2 and run a new calculation and possibly apply to modify the support order.

IRS W-4 Worksheet
This report shows the parties how to fill out the W-4 form for their employer. It shows the cor-
rect number of withholding allowances to report in order to come out about even at the end of 
the year.

timeshare Worksheet
Print this blank worksheet as a convenience to your client, to help him/her to figure the timeshare 
percentage that must be entered on Screen 1.

Case Info Worksheet
This blank worksheet contains every item of information that is required to run a support calcu-
lation. Print a copy as a convenience to your client, to help him/her collect the data that needs 
to be gathered. You can give him/her a second blank copy to send to the other party, to be used 
when the data is discussed.

tax Reports
These technical reports might be of interest to a tax accountant or attorney when doing a workup 
of the case. They show entries for Form 1040, Schedule A, and California Form 540 under three 
scenarios: Child Support only, Child and Spousal Support paid, and Family Support. If you are 
conversant with tax accounting, these reports are very important tools.
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C H a P t E R     8
tEchnical support and lEgal advicE
What support is available?

Nolo provides two kinds of support for CalSupport PRO users. 

Customer support is for business and service issues: upgrades, ordering, shipping, descriptions 
of products—anything of a general business nature. Nolo’s customer support number is (831) 
466-9922. Office staff is not trained or able to answer questions of a technical or legal nature; 
they mostly make sure orders get filled promptly.

Technical support is able to help you with any problems you have with the way the program 
works (or doesn’t work). If you can’t get CalSupport to go, or if it crashes or has bugs, contact 
technical support. Technical support staff cannot give you advice about how to use the program 
in any particular case or fact situation, nor can they advise you about the legal meaning of terms 
or results. Legal advice is available to CalSupport PRO users or their clients at Divorce Helpline 
for a reasonable charge (see below).

Tech support contacts via email or FAX will normally be answered within one business day.

Technical Support
email: support@nolotech.com
FAX: (831) 466-9927

Suggestions for improvement are invited
All of us at Nolo Press Occidental are interested in your suggestions for improving the CalSup-
port PRO program, this manual, or the way we serve you. We encourage you to give us your 
suggestions at either Customer Support or Tech Support by phone, fax, email or mail. We thank 
you for taking the trouble to do so. With your help, the tool you use will keep getting better.

How to get the most from Tech Support
Before contacting Tech Support, make sure your hardware is working. Try other programs that 
you know work and make sure they are operating correctly. If the problem persists, contact us.

1. Tell us what version of CalSupport PRO you are using.

2. Describe the problem as clearly and exactly as possible.

3. Carefully record any error messages that appear.

4. Record exactly what steps you take to make the problem happen again. It is almost impossible 
for us to solve a problem if you can’t make it happen again. 

Ideally, we will be able to make the same bug happen on our machine. If we can, the problem 
is as good as solved.

If we can’t reproduce the problem by following your steps but you can, the bug is probably 
specific to your hardware or system. 

If you can’t make a problem happen again, take notes of the problem with as much detail as 
you can about the circumstances, then restart CalSupport PRO and carry on using it. If the 
same bug ever shows up again, check your notes to see if there are any clues to help you find 
what steps you must take to reproduce the problem.
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Legal advice and counseling
Legal advice and counseling from Divorce Helpline is available to professionals using CalSupport 
PRO or directly to their clients. Divorce Helpline’s experienced family law attorneys are media-
tion trained, oriented toward settlement while protecting rights, and especially good at finding 
practical solutions and explaining things in clear language.

Divorce Helpline attorneys are conveniently available by phone at reasonable rates to give you 
or your clients advice and counseling about:

• the meaning of terms
• the meaning of results
• how to find needed information
• how to get information from or about the other party
• how to talk to the other party and negotiate an agreement
• how to find and consider alternatives and options
• how to make sure the parties get all possible tax savings
• how to use the reports in court

or anything else related to child or spousal support, divorce, or legal separation. 

Divorce Helpline attorneys are also available to draft marital settlement agreements and prepare 
court documents.

You can reach Divorce Helpline at (800) 359-7004. There is no charge when you call to inquire 
about how the Divorce Helpline service works.
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a P P E N D I X

glossarY of tErms and dEfinitions
Add-ons: see Additional child support

Additional Child Support
Family Code 4062. Also called “add-ons” or “shared child care costs.” Amounts of support that are added to 
basic guideline support. Additional child support is shared by the parents (see Sharing method, below).

a) Authorized add-ons: Also called “mandatory” add-ons. The court must order additional child support 
for amounts actually paid for the following: 

- Child-care costs that are incurred to permit a parent to work or attend reasonably necessary education 
or training for employment skills. 
- Uninsured health care costs reasonably incurred for children. Amounts actually paid for uninsured 
health costs of children would be presumed by a judge to be reasonable unless convincing evidence were 
presented to show otherwise. 
- TIP: costs that are not regular and long-term should not be included in a support calculation but should 
be handled on a case-by-case basis in a marital settlement agreement (parents agree to share uninsured 
health costs, equally or some other ratio.)   

b) Discretionary add-ons: The parties may agree or, after hearing evidence, a judge may order additional 
child support for: 

- Educational or other special needs of the children: The emphasis here would be on need and need is 
related to the special circumstances of the child and the ability of the parents to pay. 
- Travel expenses for visitation: When one parent earns significantly less than the other, or when the 
cost of visitation has been increased by a parent’s move, the parents can agree or the court might order 
an additional amount of support to help pay for the cost of visiting.    

c) Sharing method (who pays and how much?): Family Code 4061. Amounts for additional child support are 
shared equally by the parents (50/50) unless a parent requests and the court decides that sharing in proportion 
to the adjusted net incomes of the parents would be more appropriate. Many people think that proportional 
sharing is usually more fair. In general, the court will probably decide to share proportionally whenever 
there is a significant difference between the parents’ net incomes and there is no good reason not to share 
proportionally. The Family Code sets out a complex formula for proportional sharing that is automatically 
calculated by your CalSupport software.

AFDC: Aid to Families With Dependent Children
Aid to Families With Dependent Children is welfare that is paid for the benefit of minor children. Welfare for 
children is not included as income in your support calculation.

Agreed child support: see Marital Settlement Agreement

Authorized items
Sometimes (confusingly) called “mandatory deductions”. The term “authorized” is used in this manual and in 
CalSupport software to refer to items that the law says must be included in support calculations. In contrast, 
other amounts are discretionary and will be included only if the parties agree or a judge hears evidence and 
finds that it is fair to do so.

a) Authorized deductions from income: Family Code 4059. These are specific items that the law says can 
be deducted from income before calculating support. Unless it is claimed that the amount is incorrect, the 
deduction will be taken as part of the child support calculation. See Deductions: a) Authorized
b) Authorized additional support: See Additional child support: a) Authorized add-ons
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Business expenses
If a party has self-employment or rental income, the amount included for support calculation is the gross in-
come less expenses required to operate the business. “Required” means that some business expenses that are 
acceptable for taxes and accounting are not acceptable for figuring support. For example:

Depreciation expenses: Courts are often unwilling to allow depreciation deductions (particularly accelerated 
depreciation) unless it would be unfair not to allow it. Depreciation is a paper deduction, not an out-of-pocket 
expense. It is not “required” to run the business and the money is actually still available to be used for sup-
port. If it is actually deposited in an account and held to replace the depreciated item, it might be allowed.
Personal expenses charged to business: It is common for expenses that are in fact personal to be charged 
off as business expenses. This can include entertainment, meals, travel, auto expenses, furniture that actu-
ally ends up at home, and so on. These expenses may get by the IRS but are not acceptable for calculating 
support. Books, receipts and records can be audited to determine this amount, or the parties can agree on a 
reasonable figure. If this is a problem in your case, get legal or accounting advice.

Calculation options
You have several choices as to how the CalSupport calculations will be run. They are:

a) Child support options: There are two child support calculation options:
1. California guidelines: This is the default option. CalSupport will calculate the correct child support 
under current California guidelines based on all the information you have entered.
2. Set child support: This option bypasses the guidelines and lets you set the amount of child support 
at any amount. Use this option only if you have an agreement or an order for child support set at some 
particular amount and you want to focus your calculation on spousal support to see the effect of the figures 
and other options you have entered. You can also set child support to see what will result if you should 
happen to agree to a particular figure for child support. 
3. Zero child support: The correct way to get zero child support is to make sure that no children are 
entered for the parties. Do not try to use the Set Child Support option to get zero child support.

b) Child support add-on sharing: Family Code 4061. Amounts for additional child support are shared by 
the parties. There are two sharing options, Statutory and Prorated:

 Statutory 50/50: The law says that additional support amounts will be shared equally (50/50) and this 
is the default setting for CalSupport.
Prorated: If the parents agree or a judge orders it, additional child support will be prorated according to 
the relative net incomes of the parents. In general, a court would find it more fair to share proportionally 
if there is a significant difference between the parents’ net incomes and there is no good reason not to 
share proportionally. For example, a judge might feel the payor’s support burden is already high and not 
order proportional sharing for that reason. The Family Code sets out a complex formula for proportional 
sharing that is automatically calculated by your CalSupport software.

c) Hardship deduction for children: Family Code 4071 (a)(2); 4071 (b). This option determines the method 
used to calculate the maximum deduction that can be taken for live-in children of other relationships. (The 
term “hardship” is unfortunate because children of other relationships are not hardships; they are simply 
other children for whom the parent is equally responsible.)

Support paid: This is the method specified by the Judicial Council and it is, therefore, the default op-
tion in CalSupport. Under this method, the hardship deduction for other live-in children is based on the 
amount of child support actually to be paid for children subject to the guideline calculation. Unfortu-
nately, this method can sometimes be unfair to one parent or the other, depending on circumstances. For 
example, when the high earner has primary care of the children, the low earner pays little or no support 
and, therefore, the deduction allowed for children of other relationships will be unreasonably low. For 
this reason, people often agree to use the method preferred by many leading attorneys and the authors of 
this program, which is to allocate support to all children equally (see below).  
Support allocated: Under this method, each child of other relationships receives the same allocation of 
income as children who are the subject of the support calculation. All children are treated equally.

d) Spousal support options: The three options for spousal support are: 
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- choose the formula preferred by the county where the case will be filed, or 
- set a proposed or agreed amount of spousal support, or 
- indicate that there is NO spousal support.     
A fourth option, available only for CalSupport PRO users, allows the user to set the formula manually, 
in case you learn that a local judge likes some formula different from the standard ones.
Spousal support formula: Each county has a formula that it prefers. Simply select a county from the 
pick list and the preferred formula for that county will be entered. If you don’t know what county the 
case will be filed in, or if the county is one of those rare ones that has stated no preference, use the Santa 
Clara formula as it is most commonly used.
Set spousal support to be paid: Use this option if the parties have already agreed to a particular amount 
or if you want to propose an amount. In either case, you will see the reports and analysis with the spousal 
support set at whatever amount you have entered. To use this option, select to whom support will be paid 
and enter the amount.
No spousal support: Use this option only if the parties were not married or if the parties agree that there 
will be no spousal support.

Catastrophic losses: see Deductions: b) Discretionary

Child and dependent care tax credits
A tax credit is allowed for a portion of expenses paid for the care of a qualified child or dependent to enable 
you to work or look for work. In general terms, a qualified dependent is a dependent under the age of 13 or a 
disabled spouse or other dependent for whom you could claim an exemption if the person did not earn above 
the minimum amount (see Exemptions: b) Dependents). This credit involves a fairly complex set of rules, so 
be sure to read Publication 503: Child and Dependent Care Expenses, which you can get free from your local 
IRS office, or get advice from an attorney or accountant.

Child care add-ons: see Additional child support                 
Child custody: see Timeshare                             
Child support, to children of previous relationship: see Deductions

Child tax credit
Taxpayers may receive a tax credit for each qualifying child—that is, a child, descendant, stepchild or eligible 
foster child who is a US citizen, under 17 at close of the tax year, and for whom the party may claim an exemp-
tion. Enter the number of eligible children for each party and CalSupport will calculate the correct amount. 
See Exemptions: b) Dependents).

Children
a) Who to include: Include all minor children or adult incapacitated children who have been born to or 
legally adopted by the parties to the calculation. If the woman is pregnant, add one for the unborn child 
unless paternity is an issue. If paternity is an issue, get legal advice.
b) Who is a “minor” for support purposes? Parents must support a child under 18 years of age who is not 
married or self-supporting. But  Family Code 3901 extends the support duty to a  “...child who has attained 
the age of 18 years, is a full-time high-school student, ...until the time the child completes the 12th grade or 
attains the age of 19 years, whichever occurs first.”
c) Incapacitated or disabled children: Parents are obligated by law to support a child of any age who is 
incapacitated from earning a living and who is without sufficient means. Include such disabled children in 
this calculation.
d) Children of other relationships: Not included in the calculation, but child support paid for them is al-
lowed as a deduction. If they live with a party to the calculation, a “hardship” deduction may be taken. See 
Deductions: b) Discretionary, 2(a) Children of other relationships. 

Custody: see Timeshare    
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Custodial parent: see Timeshare   

Deductions
a) Authorized deductions from income: Family Code 4059. Sometimes called “mandatory” deductions by 
lawyers and judges. The law specifies certain expenses that will be deducted from a party’s income, to the 
extent they can be documented:    

1. Health insurance for the party and dependent children. Health insurance costs for spouses and other 
dependents would not be allowed in court but the parties can include such amounts by agreement.    
2. Mandatory deductions from pay; that is, non-voluntary deductions that are taken from pay as a condi-
tion of employment. Only two are permitted:

a) union dues, and 
b) payments into a retirement or pension plan.    

3. Child support actually being paid to a natural or adopted child of another relationship (i.e., not a party 
to this calculation). If not being paid per court order, the deduction is not to exceed the guideline amount.    
4. Spousal support actually being paid per court order to the spouse of another marriage.
5. Federal and state income taxes actually paid. California income tax is calculated automatically by Cal-
Support unless the user indicates that a party is not a resident of California. In that case, the user should enter 
an amount for state income tax paid in some other state. Federal income tax is calculated automatically.  
6. FICA and SDI payments: Medicare, Social Security, and SDI (State Disability Insurance) if actually 
paid. These amounts are calculated automatically by CalSupport unless the user indicates that one or all of 
them should be excluded because the employee is exempt. The correct rate is also applied to self-employment 
income. See FICA.

b) Discretionary deductions from income: Amounts paid out in the following categories may be deducted 
from income if the parties agree or if evidence is presented in court and the judge orders it:

1. Necessary job-related expenses: Family Code 4059(f). Special tools, clothing, travel, etc., that are not 
compensated by the employer but that are essential to keeping the job.
2. Hardship deductions: Family Code 4059(g), 4071. The three hardship categories are:

a) Children of other relationships who live with the party: A deduction can be taken to cover basic living 
expenses for natural or adopted children of other relationships who are living with a party to this calcula-
tion. This is the most common hardship deduction. While other hardship deductions may have to be argued, 
a judge would almost automatically allow this one unless there is a good reason not to. The maximum 
amount allowed is calculated by CalSupport. See Calculation options: c) Hardship deductions.
b) Extraordinary health expenses: Do not include uninsured health costs for children of this calculation; 
that is dealt with separately on Screen 5 as an item of additional support. This item includes uninsured 
health costs for all other persons: the party, children of other relationships, parents, new spouse, other 
dependents, etc. The party must be legally responsible for these expenses (in other words, care for a sick 
friend doesn’t count) and it goes without saying that the expenses must be uncompensated by health in-
surance. If the expenses are onetime or short-term and not recurring, treat them as uninsured catastrophic 
losses, below.
c) Uninsured catastrophic losses: A significant loss (uninsured) suffered through some catastrophe 
(earthquake, theft, fire, accident) can be eased by a deduction from income if it makes sense in terms of 
child support. Let’s say all the parent’s furniture was stolen. It could be agreed that a small amount will 
be deducted from income for a reasonable period of time to help the party recover. This deduction is 
almost never seen in practice because it is not easy to fix a period of time in your agreement after which 
the deduction will no longer be taken and child support will automatically be raised. This actually doesn’t 
make much sense as part of a child support formula, but the lawmakers put it there anyway. Better to deal 
with this item in a marital settlement agreement.    
• Hardship findings: Family Code 4072. If the court allows a hardship deduction, it must state the amount, 
the underlying facts and circumstances, the reason for allowing the deduction and the duration for the 
deduction. If the parents make an agreement to allow a hardship deduction, it is not a bad idea to include 
the same information in their marital settlement agreement.
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Deductions, tax: see Tax deductions                         
Dependents: see Exemptions: b) Dependents                      
Disability benefits: see Income: Tax free   

Discretionary items
These are amounts that the law says may be included in support calculations if the amounts paid are documented 
and if the parties agree or a judge hears evidence and orders it. In contrast, authorized items must be included 
if they can be documented. 

There are two categories of discretionary items:
a) Discretionary deductions: see Deductions: b) Discretionary
b) Discretionary additional child support: see Additional child support: b) Discretionary

Earned income: see Income: Earned income

Earned income credit
The IRS will pay some money to wage earners who meet a low income test. To claim this credit, a married 
person must file a joint return unless he or she is also qualified to file as Head of Household. See Tax filing 
status: a) Married ...Head of Household.  The maximum amount paid depends on whether the party has 0, 1, 
or 2 or more qualifying children. In tax year 2000, the maximum amounts were: 

0 qualifying children ............................ $353
1 qualifying child ................................ 2,353 
2 or more qualifying children ............. 3,888

For CalSupport purposes, if a wage earner has low income and is not married or is married and either files a 
joint return or qualifies as a married Head of Household, then go ahead and enter the number of qualifying 
children. Do not make an entry unless you are sure the party is likely to qualify and will actually apply for this 
income credit. Qualifying children must:

- be the party’s natural or adopted child, stepchild, grandchild or  eligible foster child. A married child must 
also qualify as a dependent (see Exemptions). 
- share the same primary residence with the party for more than half the year (full year for eligible foster 
children). 
- be under 19, or a full-time student under 24, at the end of the tax year, or totally and permanently disabled 
at any time during the year. 
- have a Social Security number if over 1 year old at the end of the tax year. 

This is a complicated business. To learn about it in more detail, read the free IRS Publication 596.

Earning ability
Family Code 4058(b). The court can consider earning capacity of a party instead of actual income. This is only 
done when the party has voluntarily reduced income or quit work and it can be shown that the party is qualified 
for work at a higher rate and that such work exists. If this situation exists in your case, ignore it, compromise, 
or get legal advice.

Exemptions
An exemption is a deduction (worth $2,800 in tax year 2000) that you are allowed to take from your taxes. You 
are allowed a personal exemption for yourself and one for each person who qualifies as a dependent under tax 
regulations (see below). In addition, there are special increases in the standard deduction for blind people and 
people over 65. For more details, be sure to read the free IRS Publication 504, Divorced or Separated Individu-
als, or get advice from a tax accountant.

a) Personal exemptions: Each taxpayer can claim one personal exemption. If you file a joint return with 
your spouse, you would claim two personal exemptions, one for each person.
b) Dependents: You can claim one exemption for each dependent. To be claimed, a dependent must meet 
five tests: 
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1. Relationship: The dependent must be a relative by blood or marriage, or someone who has lived in 
your home for the full tax year as a member of your household. 
2. Citizen or resident: The dependent must be a citizen, national, or resident, or a resident of Canada or 
Mexico, for some part of the tax year claimed. 
3. If married: The dependent must not have filed a joint return with his or her spouse unless neither 
the dependent nor spouse has earned enough to be required to file and they file only to get a refund of 
withheld taxes. 
4. Income: The dependent must have less than $2,800 of gross income for the year unless the dependent is 
your child and under 19 at the end of the year or is a full-time student under 24 at the end of the year. 
5. Support: You must have provided over half the dependent’s support for the year.

c) Children of divorced or separated parents can be claimed if you or both of you provided over half of 
the child’s support and one or both parents had custody of the child for more than half of the calendar year. 
The custodial parent, the one who has primary physical care of the child for more than 50% of the time, is 
the one entitled to claim the exemption. The noncustodial parent can claim the child as an exemption only 
if the custodial parent signs a release on IRS form 8332 and it is attached to the claimant’s tax return, or a 
court order or written agreement dated before 1985 provides that the noncustodial parent can claim the child 
and he or she gave at least $600 for the child’s support during the year.

Extraordinary health expenses: see Deductions: b) Discretionary 

Family support
Also called unallocated support. Family support is an order for combined child and spousal support, lumped 
together in one sum, all tax deductible to the paying spouse and included in taxable income to the receiving 
spouse. This can result in tax savings when the payor earns significantly more than the recipient because child 
support, when ordered separately, is not deductible and not included in the recipient’s taxable income. Tax 
savings must be shared with the children. 
 Using CalSupport, you can see the benefit, if any, of using family support by looking at the Results (Screen 
10), upper right. Compare the tax adjusted net incomes of both parties under the guideline and using family 
support. If there’s a big savings, family support is worth further investigation. 
 IMPORTANT: The success of family support is based on actual tax savings so it deserves accurate tax 
accounting that is beyond the ability of any support program. Take the family support  result as an approxima-
tion that helps you decide whether to consult a tax accountant for a real workup of the case. You should get 
help if you decide to use family support because: a) if not drafted exactly right, the tax deduction for the entire 
amount can easily be lost, and b) if you are not careful with tax returns and withholding allowances, you can 
lose the advantage of the family support order.

FICA: Federal Insurance Contributions Act
Includes Social Security and Medicare. FICA deductions are taken from wages by the employer or paid directly 
by self-employed persons. See also:  State Disability Insurance, a California state-run program. CalSupport 
automatically calculates and deducts contributions to FICA and SDI for all self-employment income. The same 
is true for earned income (wages) unless the employee is exempt from such deductions. Exemptions from any 
of these deductions should be entered at Screen 6, item 5.

Exempt employees: Employees of some public entities (state, county, school or college districts, fire, 
police, etc.) may be exempt from paying one or more of the FICA deductions or SDI. Find out by calling 
the personnel officer or by examining pay stubs. If any of the social insurance programs are exempted, 
be sure to indicate this on the Screen 6, line 5 popup so the deduction will not be taken automatically by 
the program.

Filing status: see Tax filing status

Findings
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Family Code 4056. In every case, the judge must state in writing or on the record certain information, and ad-
ditional information must be added at the request of any party. See the Family Code for details.

Foster Children
Beginning in 2000, a foster child is any child you cared for as your own child and who:
• Is (1) your brother, sister, stepbrother, or stepsister; (2) a descendant (such as a child, including an adopted 
child) of your brother, sister, stepbrother, or stepsister; or (3) a child placed with you by an authorized place-
ment agency, and
• Lived with you for all of 2000. A child who was born or died in 2000 is considered to have lived with you for 
all of 2000 if your home was the child’s home for the entire time he or she was alive during 2000.

Gross income: see Income: Gross income

Guideline support
Guideline support is the amount of support calculated under controlling guideline formulas as follows:

Child support: Family Code 4050 and following. The California guideline amount for child support is 
mandatory statewide and it is presumed to be correct unless evidence is introduced in court to show why the 
guideline amount is inappropriate, or unless the parties agree to a different amount.  See Guideline Support 
Formula below for details of the formula used.
Spousal support: Spousal support guidelines are local (county) and not mandatory; they are advisory only, 
meant to assist the judge in making a determination. About five different formulas are in use around Cali-
fornia and they are only slightly different from one another. The Santa Clara formula is used in about 37 
counties; the Alameda formula is used in about 8 counties.  
 Some counties have no preferred formula. Even where there is a county guideline, some judges may apply 
a different one, and where the counties have no guideline, judges are likely to refer to one anyway.
 Experience has shown that most spousal support orders tend to be fairly close to amounts indicated by 
the guidelines, so they turn out to be very useful, especially as an aid in negotiations. It usually costs far 
more to have a legal contest than you can possibly gain by going to court for an order that strays very far 
from the guideline amount. 

Guideline Support Formula
The formula for calculating child support is spelled out in California Family Code Section 4055. All income 
figures are based on Net Disposable Income (See Income as defined in Section 4059).
The formula for one child is:  CS = K (HN - (H% * TN)), where

CS equals the child support amount,
K equals the amount allocated for child support,
HN equals the high earner’s net monthly disposable income,
H% equals the percentage of time that the high earner has the children, and
TN equals the total net monthly disposable income of both parties.

 Child Support (CS): If the amount calculated under the formula results in a positive number, the higher 
earner pays that amount to the lower earner.  If the amount calculated under the formula results in a negative 
number, the lower earner pays the absolute value of that amount to the higher earner.
 Allocation (K) – The amount of both parents’ income allocated for child support equals one plus H% (if 
H% is less than or equal to 50 percent) or two minus H% (if H% is greater than 50 percent) times the following 
fraction:
Total Net Disposable
 Income Per Month  Allocation (K)

$0-800 0.20 + TN/16,000
$801-6,666 0.25
$6,667-10,000 0.10 + 1,000/TN
Over $10,000 0.12 + 800/TN
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For example, if H% equals 20 percent and the total monthly net disposable income of the parents is $1,000, 
K = (1 + 0.20) X 0.25, or 0.30.  If H% equals 80 percent and the total monthly net disposable income of the 
parents is $1,000, K = (2 - 0.80) X 0.25, or 0.30.
 Higher Earners Net Disposable Income (HN) – The net income of the higher earning parent after deduc-
tions for taxes, authorized deductions and discretionary deductions.  (See Income.)
 Percentage of time Higher Earner has the children (H%) – Approximate percentage of time that the high 
earner has or will have primary physical responsibility for the children compared to the other parent.  In cases 
in which parents have different timesharing arrangements for different children, H% equals the average of the 
approximate percentages of time the high earner parent spends with each child.
This is similar to the Timeshare Factor (See Timeshare).  In CalSupport, the Timeshare is the amount of time 
that the noncustodial parent has the child, so the timeshare factor is always less than or equal to 50%.  H% 
however can range from 0% to 100%.
 Total Net Disposable Income (TN) – The sum of the net disposable income of the two parents.

For more than one child, multiply CS by:
  2 children 1.6
  3 children 2
  4 children 2.3
  5 children 2.5
  6 children 2.625
  7 children 2.75
  8 children 2.813
  9 children 2.844
10 children 2.86

So what does it mean?  The formula calculates the payment from the higher earner to the lower earner.  If the 
number is negative, the actual payment is made by the lower earner.  But to better understand the formula, lets 
start by expanding it out so that it reads:
 CS = K * HN – K * H% * TN
Now lets look at the intent of the law, which is to support the children.  This support comes from both parents.  
The total amount of support, sometimes referred to as the total support allocated to the children, is K * TN.  
The higher earner’s portion of that is K * HN, which is the first piece of the expanded formula.
Rearranging the second piece, we see that it is K * TN time H%.  This is the amount of the total allocated sup-
port money that the higher earner spends on the child(ren) while they are in the higher earners care.
So the child support payment is the parent’s obligation minus the amount that he or she spends directly.

Hardship deductions: see Deductions: b) Discretionary

Health care costs
Health insurance, self & kids: see Deductions: a) Authorized deductions
Extraordinary health expenses: see Deductions: b) Discretionary            
Uninsured health expenses, children of parties: see Additional support

Income
Family Code 4058. In calculating support, you must include all of a party’s income from any source whatever 
excepting only child support received and welfare that is based on financial need. Yes, Social Security, pension 
and disability income are included: see “Social Security Income,” below.                                         

Adjusted net income: see “Income: Net income,” below.                 
Business income: see “Income: Self-employment income,” below.              
Capital gains: Capital gains is income (or losses) derived from the sale of capital assets such as stocks, 
real estate, gems, antiques or any other property that you bought and sold at a profit (or loss). It does not 
including goods bought and sold as part of a wholesale or retail business. Most people see capital gains 



Appendix : Glossary

73

only occasionally, in which case, any such profits might better be shared with the child as they occur in each 
instance. If capital gains income is a regular event, then average it over several years. (Long-term capital 
gains are capital gains due to the sale of a capital asset that you held for a year or more, and may be subject 
to a lower tax rate.)
Earned income: Earned income includes all amounts earned through employment with a company or a per-
son other than one’s self, including wages, salaries, overtime, commissions, bonuses, tips, and so on. Look 
on pay-stubs or W2 forms for figures. If a party is paid a salary or wage through his or her own company, 
this would be considered a salary or wage if deductions are taken from the pay check for taxes, FICA, etc. 
If no deductions are taken, the pay would be considered a draw against earnings and should be reported as 
income from self-employment. For irregular income, use average over one or two years. Use averages for 
bonuses, commissions, overtime, etc. If income has been voluntarily reduced, consider using earning ability 
instead of actual earnings. See Earning ability.
Earning capacity instead of actual income: see Earning ability            
Gross income: Gross income is the total of all income before any deductions are taken. For purposes of 
calculating child support, income from any source whatsoever will be included, excepting only child support 
received and welfare that is based on need.
Irregular or seasonal income: If income is irregular or seasonal, take the average over one or two years. If 
irregular income is predictable, the parties can agree to vary the payment schedule to make payments more 
suitable to the payor’s income patterns.
Low income adjustment: see Low income adjustment              
Net income:  There are three net income amounts that are interesting and one that is not:

Net disposable income (NDI): Family Code 4059. This is defined by law and is the basis for all support 
calculations. NDI equals gross income after deducting:

- actual state and federal income tax liability, 
- Authorized Deductions, and
- Discretionary Deductions agreed to by the parties or ordered by a judge. See Deductions

Net spendable income (NSI): This is not a legally defined amount; it is our effort to reflect what each 
party will have left to live on after child and spousal support is paid and received—an amount to bud-
get monthly expenses for each party and for the children when in their care. To get NSI, start with Net 
Disposable Income (above) then subtract child and spousal support paid out and add child and spousal 
support received, including add-on child support. Then deduct add-on child care expenses that each party 
has reported they will be spending each month. The amount left is about what each party has left to spend 
on themselves and on their children. The party that has more time with the children tends to have more 
spendable income because they have more child-related expenses. See “Net Income Report,” below.
Adjusted net income: Family Code 4061. This is a technical figure (not displayed) used to calculate the 
sharing of additional child support when parties agree to share in proportion to net incomes. 
Net Income report: CalSupport’s Net Income report shows you exactly how net disposable and net 
spendable income amounts are figured in each case. Shows what each party has to live on each month. 

New spouse or new mate income: 
New spouse: If a party has a spouse who is not a subject of this calculation, and if they file a joint tax 
return, then you can include the new spouse’s income on Screen 6, item 1a, where it is used to calculate 
the party’s taxes. However, in some cases doing this can produce results that may seem unfair. Many at-
torneys think it is better to enter the party’s tax filing status as it would be if not married and not include 
new mate income. Try it both ways and negotiate if it makes a significant difference.
New spouse or live-in mate: For the purpose of calculating child or spousal support, do not include the 
income of a new spouse or a live-in mate unless your case comes under one of the exceptions listed below. 
The rules for including new mate income are different for child and spousal support. If you do decide to 
include some amount for new mate income, enter it at Screen 8, items 1 and 2.

Spousal support: Family Code 4323. Income of a paying spouse’s new mate is NOT included when 
calculating spousal support. But, if the recipient cohabits with a member of the opposite sex, it is 
presumed that the need for spousal support is reduced, at least to the extent the recipient’s expenses 
are reduced. 
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Child support: Family Code 4057.5. The law does not favor including new mate income when cal-
culating child support. The parties can agree or a judge can order that some portion of the income of 
a new spouse or live-in mate be considered, but ONLY if the party with the new mate has voluntarily 
quit work or reduced income or if the party remains unemployed or underemployed and relies on the 
new mate’s income to do so, or (and no one knows exactly what this means) the case is “extraordinary” 
and “excluding that income would lead to extreme and severe hardship” and considering it would not 
cause severe hardship to any other child supported by the party or the new mate.
  • Whenever new mate income is used, the party with the new mate can claim a hardship deduction 
for any live-in child of the party or of the party’s new mate. See Deductions: b) Discretionary: 2a) 
Hardship children 

TIP: If the party has a good income history, and if income has been reduced in reliance on the new mate’s 
income, consider entering the party’s earning ability as income (Screen 2) instead of trying to figure out 
new-mate income. If there’s no good work history, then use new mate income, at least to the extent that 
it reduces the party’s expenses.  
Treated as tax free income: Any amount entered in CalSupport as new mate income will be treated as 
tax-free income to the party with the new mate.

Overtime and two jobs: If a party has in the past worked some overtime or a sideline job, it is reasonable 
to assume the same pattern will continue in the future. Take an average over the last year or two and include 
it in this calculation. 
 However, a person cannot be enslaved to an unreasonable work schedule, even if he or she has main-
tained one in the past. One man worked two jobs for several years, but the judge refused to base child sup-
port on a two-job schedule when the man said he wanted to resume a normal life. A reasonable amount of 
overtime and sideline work can be included if it has been a pattern in the past, but at some point it becomes 
an excessive burden and the amount to be included becomes a matter for negotiation.
Rental income: Rental income is the gross receipts from renting or leasing any real property—a room, a 
lot, a building—reduced by expenditures required to operate the rental activity. Some expenses that are al-
lowed by the IRS should not be accepted for support purposes: the parties should agree not to allow personal 
expenses charged to the business, the accelerated part of depreciation deductions, investment credits, or 
entertainment expenses, to name a few. If renting property is a significant activity, it might be considered 
self-employment income and could be reported as such. FICA would then apply. Check the party’s tax re-
turns to see how it is treated.
Self-employment income: Self-employment income is the gross receipts from the operation of a business 
or profession—whether full-time or part-time—reduced by expenditures required to operate the business 
activity. Some expenses that are allowed by the IRS should not be accepted for support purposes: the parties 
should agree not to allow personal expenses charged to the business, the accelerated part of depreciation 
deductions, investment credits, or entertainment expenses, to name a few.
Social Security income: Income from Social Security can be for dependent children, SSI, retirement, dis-
ability, or any combination of these four. Each kind of Social Security income is treated differently:      

1. Income for dependent children is not included in the child support calculation. 
2. Supplemental Security Income (SSI) is entered as tax-free income at Screen 2, item 7. 
3. Retirement and disability income are partially taxable and are entered at screen 2, item 6. 

Spendable income: see “Income: Net spendable income,” above.              
Spousal support received as income: Spousal support is included as income to the extent that it is actually 
being received from another party (someone who is not a party to this calculation). 
Tax-free income: Tax free income is income that is not subject to tax or FICA deductions. This includes 
investments in tax-free government securities, disability benefits, worker’s compensation, and certain military 
allowances. You should also include that portion of income from notes, deeds, and annuities that represents 
a return of principal.
Under the table income: It is quite common for one party to claim that the other has income that is not 
reported: cash, tips, skim, whatever. Whether or not this is true, a judge would not include income that can-
not be proved. It is a matter of evidence. You should not include income that cannot be proved unless the 
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parties can agree about it. This is what you are after: agreement.
Unearned income: Unearned income is subject to tax but not FICA deductions. This category includes inter-
est income from deeds, notes and annuities, stock dividends, unemployment compensation, royalty income, 
pension and retirement income.  It also includes casual rental income—that is, arising from rentals that do 
not constitute a business. Business rentals are entered separately at Screen 2, item 3.

Job related expenses: see Deductions: (b) Discretionary              
Joint physical custody: see Timeshare

Low income adjustment
If payor’s net disposable monthly income is $1,000 or less, it is presumed that the judge will reduce child sup-
port within a specified range (calculated by CalSupport). 

While calculating, if CalSupport detects that a payor falls within the low income definition, it asks if you 
want the low income adjustment to be applied. If you do (and why wouldn’t you?), the adjustment range is 
displayed on Screen 10 and in the Support Summary report. 

If requested by a party, a judge would look at all the circumstances and decide how much of an adjustment 
to make within the range displayed. Ideally, the parties will agree themselves on a fair figure and not have to 
take the case into court. 
The presumption that the low income adjustment will be made can be rebutted by evidence showing that the 
application of the low-income adjustment would be unjust and inappropriate in the particular case in light of 
principles spelled out in Family Code 4053 and the impact of the adjustment on the parties. 

Mandatory deductions: see Deductions: a) Authorized

Marital settlement agreement (MSA)
Family Code 4065. An MSA is a contract between spouses settling all terms of their separation or divorce, 
including property, custody and support. Subject to the approval of the court, parents can agree to an amount 
of child support that is different from the guideline. If the agreed support is lower than the guideline amount: 
a) it will not be approved if the recipient is receiving or has applied for welfare for the children (AFDC); b) 
the agreement must contain certain required language; and, c) the recipient can at any time move to modify 
the support up to guideline levels.

Medical expenses: see Deductions: a) Authorized and Tax deductions        
Medicare: see FICA                              

Military Pay and Allowances
Members of the Armed Forces receive many different types of pay and allowances. Some are taxable while 
others are not.  All income must be included in your child support calculations.  Military pay items that are 
taxable should be entered on Screen 2, Line 1, while untaxed items should be included in Screen 2, Line 7.  
For further details of how military items are handled for tax purposes, see IRS Publication 3, Armed Forces’ 
Tax Guide.

Taxable

Basic pay
Active duty 
Attendance at a designated service school
Back wages
Drills
Reserve training students
Training duty 
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Special pay
Aviation career incentives
Diving duty status
Foreign duty (outside the 48 contiguous states and the District of Columbia)
Hazardous duty inactivation
Hostile fire or imminent danger
Medical and dental officers
Nuclear-qualified officers
Special duty assignment pay
Bonuses
Enlistment 
Reenlistment
Other payments 
Accrued leave 
Personal money allowances paid to high-ranking officers
Student loan repayment from programs such as the Department of Defense Educational Loan Repayment 
Program personnel when year’s service (requirement) is not attributable to a combat zone.

Not Taxable

Special Pay
Compensation for active service while in a combat zone or a qualified hazardous duty area. Note: Limited 
amount for officers. 
Living allowances
BAH (Basic Allowance for Housing) You can deduct mortgage interest and real estate taxes on your home 
even if you pay these expenses with your BAH.
BAS (Basic Allowance for Subsistence)
Housing and cost-of-living allowances abroad whether paid by the U.S. Government or by a foreign 
government.
OHA (Overseas Housing Allowance) 
Family allowances 
Certain educational expenses for dependents
Emergencies 
Evacuation to a place of safety 
Separation
Death allowances 
Burial services
Death gratuity payments (up to $3,000) to eligible survivors 
Travel of dependents to burial site 
Moving allowances
Dislocation 
Move-in housing
Moving household and personal items
Moving trailers or mobile homes
Storage
Temporary lodging and temporary school lodging expenses
Travel allowances
Annual round trip for dependent 
Leave between consecutive overseas tours 
Per diem 
Reassignment in a dependent restricted status
Transportation for you or your dependents during ship overhaul or inactivation
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Other payments
Defense counseling
Disability, including payments received for injuries incurred as a direct result of a terrorist or military 
action
Group-term life insurance
Professional education
ROTC educational and subsistence allowances
Survivor and retirement protection plan premiums
Uniform allowances
Uniforms furnished to enlisted 
In-kind military 
Legal assistance
Medical/dental care
Commissary/exchange discounts
Space-available travel on government aircraft

Minor: see Children: b) Who is a minor?  

Modifications
 Spousal support orders may or may not be modifiable, depending on the terms of the marital settlement 
agreement or the court order.
 Child support orders can be modified at any time if there is a change of circumstances, for example, if a 
parent’s income or expenses change significantly or the child’s needs, or if the timeshare used in the calculation 
turns out to be significantly different in practice. Changes to the state guideline formula are usually considered 
to be a change in circumstances sufficient to support a modification. The procedure is quite simple if the par-
ents agree to the change, but a modification should never be made without formally changing the court’s order 
because the old order continues in force and effect until it is changed. 

New-spouse or new-mate income: see Income: New spouse or new mate income 
Net income: see Income: Net income                          
Net spendable income: see Income: Net spendable income                
Noncustodial parent: see Timeshare                        
Options: see Calculation options                           
Paycheck (Professional Version Only)
This figure is wages (earned income) plus self-employment income minus taxes.  It approximates the amount 
of money in the party’s paycheck. 

Payment Cost/Benefit
The payment cost and payment benefit are the after tax cost or benefit of the payment.  The payment cost is the 
actual payment minus any reduction in taxes due to spousal support paid.  The payment benefit is the actual 
payment received minus any increase in taxes due to receiving spousal support.  While child support and shared 
costs are included in the payment amount, they do not affect the taxes of either party.

Percent (%) of timeshare: see Timeshare                                                
Primary care: see Timeshare                              
Primary physical responsibility: see Timeshare                      
Property tax: see Tax deductions      
Release of exemptions: see Exemptions: c)                                       
Rental income: see Income: Rental income  
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Residence in California
- If you indicate that a party is a resident of California, CalSupport automatically calculates and includes Cali-
fornia income tax and costs for SDI (State Disability Income).
- If you indicate that a party is not a resident, you must enter the amount of state income tax actually paid in 
some other state and amounts paid for disability insurance, if any. 
- In rare cases where state income tax is paid in more than one state, you should  indicate that the party is not 
a resident and enter the total amount of all state income taxes and disability insurance actually paid.

Retirement payments
a) Mandatory deductions from paycheck by employer: see Deductions, a) (2) Mandatory deductions from 
pay
b) Voluntary payments to retirement plans: Amounts contributed regularly to tax-free retirement, pension 
or annuity accounts, including IRA’s, Keogh’s, 401k plans and the like are entered at Screen 7, item 2. These 
amounts are treated as follows:

1. They are not deducted from income when calculating support.
2. They are subject to FICA taxes.
3. They are deducted from income before calculating income taxes.

The net result is that taxes go down so support payments go up slightly when these amounts are deducted. 
It doesn’t make sense to some people that support should go up because the payor saves a little on taxes by 
putting money aside, so they agree not to consider these voluntary payments at all. Without agreement, they 
should be entered and considered.

Salary: see Income: Earned income                         
SDI: see State Disability Insurance                          
Self-employment income: see Income: Self-employment                  
Shared child care costs: see Additional child support: c) sharing method  

Social Security
A federal retirement and disability insurance program funded by contributions paid by employers, employees 
and self-employed persons. One of the FICA deductions. 

a) Deductions: Deductions from income for Social Security are taken from wages by the employer or paid 
directly by self-employed persons. CalSupport automatically calculates and deducts contributions to FICA 
and SDI for all self-employment income. The same is true for earned income (wages) unless the employee 
is exempt from such deductions. Exemptions from FICA deductions are entered at Screen 6, item 5.

Exempt employees: Employees of some public entities (state, county, school or college districts, fire, 
police, etc.) may be exempt from paying Social Security deductions. Find out by calling the company 
payroll department or by examining the pay stubs. If the deduction is exempted, be sure to indicate this 
on Screen 6 so the deduction will not be taken automatically by the program. However, do enter as de-
ductions any amounts that are deducted from paychecks for substitutes for Social Security programs.

b) Social Security income: see Income: Social Security

Special Circumstances
Rare in practice:  A judge can depart from the guideline amount if it is found by a preponderance of evidence 
that the guideline amount would be unjust or inappropriate due to one or  more of the following:

a) Paying parent has extraordinarily high income and guideline amount exceeds the needs of the child.
b) A parent is not contributing to needs of the child in proportion to that parent’s custodial time.
c) Different time sharing arrangements for different children (but note —this can usually be handled fairly 
well by CalSupport).
d) Parents have about equal time share but one spends a much higher or lower percentage of his or her 
income on housing. 



Appendix : Glossary

79

e) Children have special medical or other needs that would require support above guideline amount (assum-
ing payor can afford it).

If proved, the judge has discretion to adjust the support; there is no formula to say how much. If any of these 
apply in your case, use them as factors in negotiating an agreement and include reference to your particular 
circumstances in your agreement. Get legal advice or call Divorce Helpline for more help.

Spousal support paid to previous spouses: see Deductions: a) Authorized

Spousal support formulas
Although the spousal support guideline is not binding on any judge, it is important to note that most judgments 
fall fairly close to guideline. Read the Support Summary report for more information about spousal support. 
Also read Chapter 6 in the manual.
 Most counties in California have a preferred formula. The Santa Clara formula is used in 37 counties, the 
Alameda formula is used in 8 counties, and three other formulas are used in the other counties that express a 
preference. Even in counties without a preferred formula, most judges will use one for guidance. Most formulas 
are variations on the one developed by Santa Clara, awarding slightly less spousal support when child support 
is being paid. The difference is not large in most cases. 
 The Santa Clara formula awards 40% of the high earner’s net disposable income LESS 50% of the low 
earner’s net disposable income. All county formulas use this 40/50 formula when there is no child support, but 
if child support is being paid, some counties change the percentages: 

Santa Clara ..... no change
Alameda ......... 35% - 40% 
Marin ............. 35% - 45% 
San Diego ...... 35% - 50% 

    If you are in a county that has expressed no preference, the formula used becomes a matter for discussion 
between the parties. Try running the calculation with different formulas to see what happens. We suggest you 
use the Santa Clara formula because it is by far the most popular, or the Alameda formula which is second. 
 Negotiate. Compromise. Calculate how much you save even if a judge sees things your way (never a certain 
thing) then compare that to the $20,000 to $60,000 that a trial will cost each party.

State Disability Insurance (SDI)
SDI is an authorized deduction from income when it is actually being paid. It is calculated automatically and 
included by CalSupport unless the user indicates (Screen 6) that the party is exempt from paying it. Residents 
of another state do not pay it but may deduct any amounts paid for similar  coverage (entered at Screen 6, item 
3) along with income tax paid in another state.

Employees of some public entities (state, county, school or college districts, fire, police, etc.) may be ex-
empt from paying SDI deductions. You can find out by calling the personnel officer or by examining the pay 
stubs. If exempt, be sure to indicate this on Screen 6 so the deduction will not be taken automatically by the 
program. If the exempt party is paying an SDI equivalent, that amount should be deducted.

State income tax
State income tax and SDI is calculated automatically by CalSupport if you indicate that a party is a resident 
of California. If a party is resident of another state, or if a party pays income tax in another state in addition to 
California, indicate that the party is not a resident and enter the total amount of state income tax actually being 
paid. See Residency in California.

Status: see Tax filing status
Tax adjusted net income: see Income: Net income

Tax credits
Credits against taxes due are designed to assist selected people or situations as a matter of public policy. Here 
are some of the commonly used ones:
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a) Child and dependent care credit: see Child and dependent care tax credit
b) Child Tax Credit: see Child tax credit
c) Earned income credit: see Earned income credit
d) Renter’s tax credit: This is a California state tax credit for renters. The owners of property get a lot of 
tax deductions and this tax credit gives a tiny little something to the renters who pay the money that pays 
the expenses that landlords deduct.
e) Joint Custody Head of Household (JCHH) credit: This is a California credit available to taxpayers who 
use the single or married filing separately status and who meet the support test for a child.

There are many other tax credits for such things as: elderly or permanently and totally disabled; interest on low 
income mortgages; electric vehicles; and so on. You may want to read a tax manual or consult an accountant 
to see if there are any tax credits that are available to you.
Some credits are refundable.  This means that the IRS will pay you money if the credit is greater than the tax 
burden.  This may result in a negative tax bill.  Other credits can only reduce you tax burden and will result in 
a tax bill of zero if the credit is greater than the tax burden.

Tax deduction method
When filing a tax return, a taxpayer can either itemize all deductible expenses or take a “standard” deduction. 
The amount of the standard deduction is fixed by regulation from year to year. When using CalSupport, you can 
choose the standard deduction, itemize deductions, or estimate the amount of taxes. These work as follows:

 a) Standard deduction: If you choose this method, CalSupport will automatically apply the standard 
deduction. Many attorneys believe that the fairest way to figure support is to use the standard deduction 
method for both spouses. This is because a person who has high expenses pays less taxes, so has more left 
over to pay for support. They think it unfair that higher expenses should result in higher support. For ex-
ample, why should tithing to your church or straining to put more away for retirement, or paying into a high 
mortgage mean that you pay more support? On the other hand, the recipient would probably rather force the 
careful calculation of tax savings in order to get more support. It’s a subject for negotiation.
  b) Itemized deductions: For people who have high deductible expenses, especially home mortgages 
and property taxes, itemizing expenses can produce lower taxes and therefore somewhat higher support. 
The results may be more accurate in such cases than using the standard deduction.  The more accurate the 
entries, the more accurate the tax calculations will be.  They will be the most accurate if the entries are 
generated by an accountant. If your figures for the current year are substantially the same as last year, you 
can take the figures from last year’s tax return.

Tax filing status
Your filing status determines your tax rate, the amount of your standard deduction, whether you can claim 
certain deductions and credits, etc. Some filing statuses are more advantageous than others: for example, single 
is not favorable and married filing separately is even less favorable. The status that you can choose depends 
in large part on your marital status on the last day of your tax year; for individuals, this is almost always De-
cember 31. 

Tax filing statuses that you can choose:
a) Married on December 31. You are considered married for the whole year if by December 31 you have 
not obtained a final judgment for annulment, divorce or legal separation. You may file either:   

1. Married Filing Separately (MFS): This is not financially favorable but has the advantage of keeping 
your finances entirely separate from your spouse’s finances. You are not responsible for your spouse’s 
taxes and any refunds will come directly to you.   
2. Married Filing Jointly (MFJ): This has financial advantages but also means that you are liable for 
taxes, interest and penalties on your spouse’s income. If a refund is due, you have to be able to work out 
between you how you will each receive your fair share.   
3. Head of Household (HH): This is an advantageous status, but if you are married, you can file as head 
of household only if you meet all of the following: 

- you file a separate return; 
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- your spouse did not live in your home for the last six months of the tax year (This can get sticky if 
your spouse is still on the deed or rent agreement during the six month period, or stayed over to care 
for the children, or kept the address for official mail, etc. If the facts are not perfectly clear, you may 
need to get advice on this point.); 
- for more than half the year your home was the main home of your child (or step or foster child) whom 
you can claim as a dependent. (Note: so long as you are legally entitled to claim the dependent, it doesn’t 
matter if you agreed in writing to allow the noncustodial parent to claim the dependent instead.)
- you can satisfy the other Head of Household requirements for single people, described below.

b) Not married on December 31. You are considered not married for the whole year if by December 31 
you have obtained a final judgment for annulment, divorce or legal separation. You may file either:   

Single: This is not a favorable tax filing status.   
Head of Household (HH): This is an advantageous status. You can file as head of household only if you 
meet all of the following: 

- on the last day of the year you were unmarried (or considered unmarried as explained above); 
- during the year, except for temporary absences, you paid more than half the cost of maintaining the 
main home for you and for any person whom you can legally claim as a dependent. Generally speak-
ing, this would be a child or other relative, but for other possible dependent categories get advice or 
see IRS Publication 504, “Divorced or Separated Individuals.”

Tip: Married to the other party: If on December 31, you are married to the other party to this calculation 
(not a new or different spouse), then you should answer CalSupport as if a planned divorce or separation is 
already final. Choose one of the statuses described above for unmarried people. This is because you want 
a support figure that will be based on the facts as they are soon to be: the longer future during which you 
will no longer be married to this party. However, if you will in fact be filing your next tax return as a mar-
ried person, you do need advice on how to handle the filing to protect yourself against tax liability for your 
spouse’s income and how to make sure tax charges or refunds can be handled fairly.
Tip: Married to a different party: If on December 31, you are married to someone who is NOT a party to 
this calculation, then you may wish to choose Head of Household as your tax filing status rather than Mar-
ried Filing Jointly. This may give you better results for support calculation purposes, even if it is technically 
not the correct status. 
 It is important to remember that CalSupport is not a tax program, it is a support program. For the pur-
pose of figuring support, CalSupport does NOT consider the income of any spouse who is not a party to this 
calculation. This is because the law severely restricts use of new-mate income for calculating support.  The 
income entered on the New Spouse popup on Screen 7 is not considered for support purposes. It is used to 
help to set the proper tax bracket.  If Married Filing Jointly is chosen, CalSupport calculates the tax burden 
on the couple.  The amount deducted from the party’s income is that tax burden times the proportion of the 
total income that is theirs.

Timeshare
Timeshare is the relative amount of time, expressed as a percentage, that the noncustodial parent has primary 
physical responsibility for the child. Some people still call this “visitation.” Timeshare is one of many fac-
tors used to determine child support.  (See Estimating Timeshare Factors for the factors associated with some 
standard time share arrangements.)

Standard or “reasonable” visitation:  If you don’t figure it precisely, 20% is considered to be an aver-
age or standard amount of visitation time. Twenty percent is roughly equivalent to every other weekend 
and one month in the summer.

Child custody: For child support purposes, custody is expressed in terms of primary physical responsibil-
ity. You have to figure out or estimate what percentage of the year each parent will have primary physical 
responsibility of each child. Here’s how to tell who’s who: 

Custodial parent (CP): The parent who has primary physical responsibility for the child more than 50% 
of the time. If the timeshare is exactly 50%, then one parent can arbitrarily be designated the custodial 
parent just for the purposes of support calculation; the designation does not affect the results. 
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Noncustodial parent (NCP): The parent who has primary physical responsibility for the child less than 
50% of the time.
Joint physical custody does not necessarily mean that each parent has the child exactly half the time. 
You can have an order for joint custody that specifies that the parents will share custody 70/30 or any 
other reasonable arrangement. However, the parent that has the lower percentage of time would, just for 
the purpose of support calculation, be considered the noncustodial parent.  
Exactly equal (50/50) timeshare: If the timeshare is in fact exactly 50/50, then one parent should ar-
bitrarily be designated the custodial parent, for purposes of support calculation. This just keeps things 
straight and won’t affect the results. It you have exactly (50/50) timeshare and only one child, let the 
parent with the highest income have 51% timeshare so that parent can file as Head of Household. If the 
parents have about equal incomes, see a tax consultant. Get some advice. 

Travel expenses for visitation: see Deductions: b) Discretionary          
Unemployment income: see Income: Unearned                       
Uninsured catastrophic losses: see Deductions: b) Discretionary            
Uninsured health expenses: see Deductions: b) Discretionary  
Union dues: see Deductions: 1) Authorized   
Voluntary payments for retirement: see Retirement: b) Voluntary payments                           
Wages: see Income: Earned income  
Withholding on wages
Employers are required to withhold from employee’s gross pay an amount meant to prepay income taxes that 
are likely to be due at the end of the year. The amount withheld is governed by regulations and information 
furnished by the employee. To make the withholding more accurate, the employee can reduce the amount with-
held by claiming a standard deduction, exemptions that are available for himself and other dependents, and 
additional withholding allowances if applicable. Some people decide not to claim all available exemptions and 
allowances, preferring to overpay and receive a refund at the end of the year when tax returns are filed. This is 
like a forced saving plan but has the disadvantage of receiving no interest on the accumulated funds.

Withholding allowances
In addition to the standard deduction and permitted exemptions, withholding allowances are available to an 
employee who can show that there will be a large number of deductions, deductible spousal or family support 
payments, moving expenses, retirement contributions, and so on. CalSupport attempts to help in the withholding 
process by suggesting the correct number of allowances each party should claim to approximate the computed 
tax due. This information is reported on the IRS W-4 Worksheet (Report Menu).

Workers compensation: see Income: Tax-free   
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NOTICE: BY USING CALSUPPORT PRO, YOU AGREE TO BE BOUND BY THE TERMS 
OF THIS AGREEMENT. If you do not agree to any of these terms, you are not licensed to 
use the product and you should not use it.

Nolo Press Occidental hereby grants to you a nonexclusive limited license to use CalSup-
port™ PRO on the following terms and conditions:
1. You may:

– install and use CalSupport PRO on one stand-alone computer at any one time; and 
– copy CalSupport PRO for backup and archival purposes only.

2.  This is a license agreement and not an agreement for sale. Nolo Press Occidental con-
tinues to own your copy of CalSupport PRO and all other copies that you are authorized by 
this agreement to make. Your rights to use CalSupport PRO are specified in this agreement 
and Nolo Press Occidental retains all rights not expressly granted to you in this agreement.
3.  This license is valid for one calendar year commencing January 1 of the year in which 
it is purchased, and ending December 31 of that same year. Lacking new tax tables for the 
subsequent year, the program and the license will expire on March 31 of the subsequent 
year. If updates are not available for purchase by the time the program expires, Nolo Press 
Occidental will provide electronic extensions by email that will allow the program to operate, 
and will continue to do so until such time as updates become available.
4. Nolo Press Occidental warrants that the diskette on which CalSupport PRO is furnished 
is free from defects in material and workmanship and the software is properly recorded on 
the diskette. Nolo Press Occidental further warrants that CalSupport PRO under normal use 
and in accordance with the accompanying operating instructions will materially perform in 
accordance with its accompanying documentation. The above warranty is made for a period 
of 90 days from the date you acquire CalSupport PRO. 
5. You assume responsibility for the selection of CalSupport PRO to achieve your intended 
results, and for the installation, use and results obtained from CalSupport PRO.
6.  Nolo Press Occidental (Vendor) does not warrant that CalSupport PRO will meet your 
requirements or that its operation will be uninterrupted or error-free. Vendor excludes and ex-
pressly disclaims all express and implied warranties not stated herein, including the implied 
warranties of merchantability and fitness for a particular purpose. Vendor’s liability in any 
event shall not exceed the amount you originally paid for the product. In no event will Vendor 
be liable for any indirect, special, incidental, or consequential damages (including loss of 
profits) even if Vendor or any of its agents have been advised of the possibility of such dam-
ages.
7. This is the entire agreement between Nolo Press Occidental and you relating to your 
right to use CalSupport PRO, and it supersedes any other document or communications 
concerning such right. No modification of this Agreement will be valid unless it is in writing, 
and is signed by Nolo Press Occidental. 




